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ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP  

 
 ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP เปนชุดทดลอง “dsPIC” ขนาดเล็ก โดยตัว
บอรดไดรับการออกแบบใหสามารถรองรับการศึกษาเรียนรูเกี่ยวกับสถาปตยกรรมของไมโครคอนโทรลเลอร
ตระกูล dsPIC จากคาย Microchips ในขั้นพื้นฐานไดอยางครบถวน ภายใตงบประมาณที่เรียกวาประหยัด
และคุมคามากที่สุด โดยตัวบอรดเลือกใช MCU เบอร dsPIC30F2010 เปน CPU ประจําบอรด พรอมทั้งจัด
วงจรพื้นฐานอื่นๆที่จําเปนรวบรวมไวภายในบอรด ไมวาจะเปนแหลงจายไฟ วงจรแสดงผลการทํางานของ 
Output แบบ LED ,วงจรสรางสัญญาณ Input Logic แบบ Push-Button Switch ,วงจรสรางสัญญาณ 
Input Analog แบบใชตัวตานทาน ปรับคาแรงดัน 0-5V ,วงจรกําเนิดเสียงดวยลําโพงขนาดเล็ก ,วงจร Line 
Driver สําหรับพอรตสื่อสารอนุกรม RS232 และวงจร Download แบบ ICSP เปนตน 
  นอกจากนี้แลวตัวบอรดยังไดออกแบบใหมีพื้นที่สําหรับใชตอทดลองวงจรขนาดเล็ก โดยมีทั้งสวนที่
เปนลาย PCB แบบจุดไขปลา หรือ อาจติดตั้งแผง Photo Board ขนาด 360 จุดเพื่อใชเปนพื้นที่ตอวงจร
ตางๆเพิ่มเติมไดเองตามตองการโดยใชชุด “ET-Hardware KIT” นอกจากนี้แลวยังสามารถนําบอรด I/O 
ขนาดเล็ก ซึ่งทางทีมงาน อีทีที จัดเตรียมไวเปนทางเลือกและสนับสนุนการทดลอง ซึ่งเรียกวาชุดโมดูลการ
ทดลอง “Mini I/O Module” แบบตางๆ ไมวาจะเปน ชุดทดลอง DC-Motor ,ชุดทดลอง Stepping Motor ,
ชุดทดลอง I2C ตางๆ ซึ่งมีทั้งชุดทดลอง I2C I/O PCF8574 ,ชุดทดลอง I2C EEPROM 24xx ,ชุดทดลอง 
I2C RTC เบอร DS1307 ,ชุดทดลอง I2C RTC เบอร PCF8583 ,ชุดทดลอง SPI โดยใช SPI Output เบอร 
74HC595 ,ชุดทดลอง Matrix Keyboard ขนาด 4x4 ,ชุดทดลอง 7-Segment ฯลฯ 
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คุณสมบัติของบอรด ET-dsPIC30F2010 TRAINING KIT V1.0 EXP 
บอรด ET-dsPIV30F2010 TRAINING KIT V1.0 EXP จะประกอบไปดวย วงจรพื้นฐานที่จําเปน

สําหรับการศึกษาเรียนรูและทดลองใชงานทรัพยากรตางๆของ MCU ตระกูล dsPIC โดยภายในบอรดได
จัดเตรียมวงจรใชงานที่จําเปนไวใหใชงานอยางครบถวนไดแก  

 ใช dsPIC30F2010 เปน MCU ประจําบอรด โดยขาสัญญาณตางๆจาก MCU จะถูก
จัดเรียงไวอยางเปนระเบียบ ผาน “Pin Header” พรอมลายพิมพขาว แสดงชื่อขาสัญญาณ 
อยางชัดเจน เพื่อใหงายและสะดวกตอการตอทดลองใชงานขาสัญญาณตางๆ โดยไมถูก
จํากัดหนาที่การใชงานดวยวงจรแบบใดแบบหนึ่ง ทําใหผูใชสามารถทดลองใชงานฟงกชั่น
ภายในผานขาสัญญาณตางๆ ของ MCU ไดโดยอิสระและครบถวนตามตองการ 

 วงจรแหลงจายไฟ แบบ Bridge Rectifier ขนาด 1A พรอมวงจร Filter สามารถใชกับ
แหลงจายไฟไดทั้ง AC และ DC ขนาด 14-18V 

 วงจร Regulate ขนาด +5V / 1A สําหรับใชงานเปนแหลงจายไฟเลี้ยงวงจรใหกับ MCU 
และอุปกรณการทดลองตางๆ พรอม LED แสดงสถานะสีแดง และจุด Connector 
เชื่อมตอใชงาน ทั้งตัวผูและตัวเมีย 

 วงจร Regulate ขนาด +13V / 100mA สําหรับใชเปนแรงดันโปรแกรม ในการ Download 
ขอมูลแบบ HEX File ใหกับหนวยความจําโปรแกรม (Flash) ของ MCU ภายในบอรด 

 วงจร Download แบบ ICSP โดยใชงานรวมกับ “ET-CAP10P V2.0” สําหรับใชพัฒนา
โปรแกรมใหบอรด พรอม LED แสดงสถานะสีเหลือง สามารถ Download HEX File จาก
คอมพิวเตอร PC ใหกับ MCU ในบอรดไดทันที โดยไมตองใชเครื่องมือโปรแกรมอื่นๆอีก 

 วงจร Line Driver สําหรับพอรตสื่อสารอนุกรม RS232 จํานวน 2 ชอง โดยเชื่อมตอกับ
สัญญาณ RC13(TXD) และ RC14(RXD) จํานวน 1 ชอง สวนที่เหลืออีก 1 ชอง จะปลอย
วางไวเปนอิสระ เพื่อใหผูใชสามารถตอทดลองการติดตอส่ือสาร RS232 โดยใชสัญญาณ
จาก Pin I/O อ่ืนๆของ dsPIC เชน ตอกับขาสัญญาณ RF2(RXD) และ RF3(TXD) ได 

 วงจร LED แสดงผลแบบ Sink Current ใชไฟเลี้ยง +5V โดยใช LED สีแดงขนาด 3mm. 
จํานวน 4 ชุด สําหรับใชในการทดสอบการทํางานของ Output ตางๆ 

 วงจรปรับแรงดัน 0-5V โดยใชตัวตานทานปรับคาไดแบบเกือกมาแบบมีแกนปรับ จํานวน 4 
ชุด สําหรับใชในการทดสอบการทํางานของ A/D  

 วงจร Push-Button Switch จํานวน 4 ชุด สําหรับใชทดสอบการทํางานของ Input ตางๆ 
 วงจร Mini Speaker สําหรับใชทดสอบการกําเนิดเสียง Beep หรือเสียงอื่นๆ 
 พื้นที่สําหรับบัดกรีวงจรเพิ่มเติมขนาด 8cm x 4.5cm หรือใชเปนพื้นที่ติดตั้ง Photo Board 
รุน AD100 ขนาด 360 จุด สําหรับตอทดลองวงจรตางๆ 
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คุณสมบัติของ dsPIC30F2010 
 dsPIC30F2010 เปน MCU ซึ่งใชการประมวลผลขอมูลแบบ 16 บิต จากคาย Microchips ซึ่งมี
จุดเดนในดานของความสามารถในการประมวลผลขอมลูสัญญาณแบบดิจิตอล สําหรับนาํไปประยุกตใชใน
งานควบคุมตางๆ โดยโครงสรางภายในจะเปนการผสมผสานระหวางไมโครคอนโทรลเลอร (MCU) และ
วงจร DSP (Digital Signal Processing) รวมเขาไวดวยกนั หรืออาจเรียก MCU ตระกูล dsPIC วาเปน 
DSC หรือ Digital Signal Controller ก็ได 
 ซึ่งในปจจุบัน MCU ในตระกูล dsPIC ของ Microchips นัน้จะมีการผลิตออกมาจาํหนายให
ผูใชงานไดเลือกใชงานกนัอยูมากมายหลายเบอรตามความเหมาะสมของงาน โดยปจจุบัน (ตุลาคม 2548) 
dsPIC จะแบงออกเปน 5 กลุม ใหญๆดวยกนั ไดแก dsPIC30F20xx ,dsPIC30F30xx ,dsPIC30F40xx 
,dsPIC30F50xx และ dsPIC30F60xx ซึ่งทกุเบอรจะใชโครงสรางและสถาปตยกรรมการประมวลผลแบบ
เดียวกนัทัง้หมด แตจะมีความแตกตางกนัในเรื่องของทรพัยากรภายใน เชน ขนาดของหนวยความจําใชงาน 
จํานวนของ Peripheral I/O แบบตางๆ ซึง่อาจมกีารบรรจุไวในแตละเบอรดวยจํานวนที่ไมเทากัน ซึ่งในที่นี้
จะขอกลาวถึงเพียงเฉพาะขอมูลในสวนทีเ่ปนของ dsPIC30F2010 เทานั้น 
 

คุณสมบัติดานการประมวลผล 
 ใชสถาปตยกรรมแบบ RISC โดยมี 84 คําสั่งมาตรฐาน รองรับการอางตําแหนงแอดเดรส
แบบตางๆไดโดยอิสระ โดยรูปแบบโครงสรางการจัดผังหนวยความจาํจะดัดแปลงมากจาก
สถาปตยกรรมของ “Harvard Architecture” 

 ชุดคําสั่ง ใชการอางแอดเดรสแบบ 24บิต และการอางถงึขอมูลขนาด 16บิต 
 มีหนวยความจําโปรแกรมแบบ Flash ขนาด 12KByte (4KWord) สามารถทาํการลบและ
โปรแกรมซ้ําใหมไดกวา 100,000 คร้ัง พรอมระบบปองกันการอาน 

 มีหนวยความจํา RAM ขนาด 512 Byte 
 มีหนวยความจําขอมูลถาวรแบบ EEPROM ขนาด 1KByte สามารถลบและเขียนซ้าํไดกวา 

1,000,000 คร้ัง และสามารถเก็บรักษาขอมูลไวไดแมไมไดจายไฟเลี้ยงให MCU  
 มีรีจิสเตอรขนาด 16 บิต ใหใชงานจํานวน 16 ชุด 
 สามารถประมวลผลดวยความเร็วสูงสุดที่ 30 MIPS(30 ลานคําสัง่ตอวนิาท)ี 
 รองรับสัญญาณนาฬกิาจากแหลงกาํเนิดภายนอก 0-40 MHz 
 รองรับการใชงานกับแหลงกาํเนิดความถี่แบบ XTAL คา 4-10 MHz 
 มีวงจรคูณความถี่ภายในแบบ Phase-Lock-Loop โดยสามารถกาํหนดคาอัตราการคูณ
ความถี่ได 3 ระดับ คือ 4 เทา ,8 เทา และ 16 เทา 

 รองรับการ Interrupt ไดถึง 27 แหลง พรอมสัญญาณ Interrupt จากภายนอก 3 แหลง 
และสามารถจดัระดับความสําคัญของการ Interrupt ได 8 ระดับ 
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คุณสมบัติของ Peripheral I/O 
 ขาสัญญาณ I/O สามารถจายกระแส(Source) และ รับกระแส (Sink) ไดมากถงึ 25mA 
 มี Timer ขนาด 16 บิต จาํนวน 3 ชุด และสามารถโปรแกรมใชงานเปน Timer แบบ 32 บิต
ไดโดยใช Timer  16 บิต 2 ชองรวมกนั 

 มี Input Capture ขนาด 16 บิต จํานวน 4 ชอง 
 มี Output Compare/PWM ขนาด 16บิต จํานวน 2 ชอง 
 มีวงจรสื่อสารอนุกรมแบบ SPI จํานวน 1 ชอง 
 มีวงจรสื่อสารอนุกรมแบบ I2C จํานวน 1 ชอง 
 มีวงจรสื่อสารอนุกรมแบบ UART จํานวน 1 ชอง 
 มีวงจร DCPWM สําหรับใชควบคุมมอเตอร 3 ชอง 
 มีวงจรถอดรหสัแบบ QEIM ขนาด 16บิต จํานวน 1 ชอง 
 มีวงจร A/D ขนาด 10บิต จํานวน 6 ชอง 

 

 
 

ตาราง แสดงความแตกตางของ dsPIC เบอรตางๆ 
 

 
รูปแสดง การจัดเรียงขาสัญญาณของ dsPIC30F2010 
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โครงสรางบอรด ET-dsPIC30F2010 TRAININGT KIT V1.0 / EXP 
 

อุปกรณภายในกรอบสีแดงจะไมมีอยู ในรุน “ET-dsPIC30F2010 TRAINING KIT V1.0” แตจะมี
อยูเฉพาะในรุน “ET-dsPIC30F2010 TRAINING KIT V1.0 EXP” เทานั้น 
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ขั้วตอ DOWNLOAD (ET-EMPIC) 
 
 

NC
WVCP
WPGD

NC

WVPP
WPGC
RPGD
NC

GND

DOWNLOAD(ET-EMPIC)

GND

 
 
 

 
 
 

รูปแสดง การเตรียมการ Download ของบอรด ET-dsPIC30F2010 
 

   ข้ัวตอ “DOWNLOAD” นี ้ จะใชสําหรับ 
เชื่อมตอกับชดุ “ET-CAP10PIN V2.0“   ผานทาง
ข้ัวตอของชุดที่ชื่อวา “ET-EMPIC” โดยใชสาย
แพรขนาด 10 Pin เปนสายเชื่อมตอสัญญาณ
ระหวางบอรดทั้งสองเพื่อใชสําหรับส่ัง Download 
HEX File ใหกับหนวยความจําโปรแกรม (Flash) 
ของ MCU ในบอรด “ET-dsPIC30F2010” 
ในขณะที่เลือกสวิตช “PROG/RUN” ไวทางดาน 
“PROG” โดยสามารถใชโปรแกรม “WinPic800” 
หรือ โปรแกรม “Melabs Programmer” เปนเปน
โปรแกรมสําหรับส่ังงานก็ไดตามตองการ 

ขั้ว DOWNLOAD 

ตอกับพอรต LPT 
(Printer Port) 

ใชขัว้ตอ ET-EMPIC 

16VAC/DC 
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การใชงาน LED แสดงผล 
 LED แสดงผลของบอรด จะตอวงจรแบบรับกระแส (Sink Current) โดยใชกับแหลงจาย +5V 
ทํางานดวยโลจิก “0” (0V) และหยุดทํางานดวยโลจิก “1” (+5V) โดยมทีั้งหมด 4 ชุด โดยวงจรในสวนนี้จะใช
สําหรับทดสอบการทาํงานของ Port I/O ตางๆทีท่ํางานใหผลเปน Output แบบโลจิก 
 

LED560
+5V

L
E

D
n  

 
การใชงานวงจรปรับแรงดัน (0V-5V) 
 วงจรปรับแรงดันของบอรดจะใชตัวตานทานปรับคาไดแบบเกือกมา ชนิดมีแกนหมนุสําหรับปรับคา 
โดยวงจรนี้ใชกับแหลงจาย +5V โดยจะให Output เปนแรงดันซึง่มีคาระหวาง 0V ถึง +5V ตามการปรับคา
ของตัวตานทาน ซึง่มทีั้งหมด 4 ชุด ใชสําหรับสรางแรงดัน Input เพื่อทดสอบการทํางานของวงจร A/D 
 

10K

+5V

V
O

L
n

 
 
การใชงานวงจร Push Button Switch 
 วงจร Push Button Switch จะใชวงจร Switch แบบ กดติด-ปลอยดับ (Push Button) พรอมวงจร 
Pull-Up ใชกับแหลงจาย +5V โดยในขณะที่สวิตชยงัไมถกูกดจะใหคาสถานะเปนโลจกิ “1” แตเมื่อสวิตชถูก
กดอยูจะใหสถานะเปนโลจกิ “0” โดยวงจรสวนนีจ้ะมีอยูดวยกนั 4 ชุด ใชสําหรับทดสอบการทํางานของ I/O 
ตางๆที่ตองควบคุมการทาํงานขอวงจรดวย Input แบบโลจิก 
 

Switch

10K

+5V

SW
n
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การใชงาน วงจรกําเนิดเสียง 
 วงจรกาํเนิดเสยีง จะใชลําโพงขนาดเล็ก (Mini Speaker) พรอมดวยวงจรทรานซสิเตอรแบบ NPN 
สําหรับขับกระแสใหกับลําโพง ใชกับแหลงจายขนาด +5V ทาํงานดวยโลจิก “1” และหยุดทํางานดวยโลจิก 
“0” โดยในการทาํงานนั้นตองสงสัญญาณโลจิกที่เปนความถี่ตางๆใหกับลําโพงเพือ่สรางเปนความถี่เสยีง
ยานตางๆ ตามตองการ 
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วงจรแหลงจายไฟ 
 วงจรแหลงจายไฟสามารถใชงานไดกับไฟ AC และ DC ขนาด 14-18V ไดทันท ี โดยวงจรภาค
แหลงจายไฟในสวนที่เปนวงจร Regulate นั้นจะมทีั้งสวนที่เปน +5V / 1A และ +13V/100mA โดยสวนที่
เปน +5V จะถูกใชสําหรับเปนแหลงจายไฟเพื่อจายใหกบั MCU และวงจร I/O ตางๆภายในบอรด สวน
แรงดัน +13V จะใชสําหรับเปนแรงดันสาํหรับการ Download โปรแกรม แบบ ICSP ของบอรด 
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การพัฒนาโปรแกรมของบอรด 
 สําหรับการพฒันาโปรแกรมของบอรด “ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP” นัน้ จะ
แบงออกเปน 2 สวนดวยกัน คือ สวนของการพัฒนาโปรแกรม และการ Download โปรแกรม โดยในสวน
ของการพฒันาโปรแกรมของบอรดนั้น จะเปนการเขียนโปรแกรมเพื่อควบคุมและสั่งงานให MCU สามารถ
ทํางานตามจดุประสงคที่ไดออกแบบไว ซึง่ในสวนนี้เปนหนาที่ของผูพฒันาโปรแกรม วาจะเลือกใชภาษาใด
ในการพัฒนาโปรแกรม รวมไปถึงการเลอืกใชโปรแกรมสําหรับทําหนาที่แปลคําสัง่ของภาษานัน้ๆ ใหเปน
รหัสคําสั่งในรูปแบบของ HEX File สําหรบัใช Download ใหกับหนวยความจําโปรแกรม (Flash Memory) 
ของ MCU เพือ่ส่ังงานให MCU ปฏิบัติตามคําสั่งในโปรแกรมที่ผูพฒันาโปรแกรมเขียนขึ้นมา 
 สําหรับสวนของการ Download โปรแกรม หรือการ Download HEX File ที่ไดจากการพัฒนา
โปรแกรมใหกบัหนวยความจําโปรแกรม (Flash Memory) ของ MCU นั้น จะตองอาศัยเครือ่งมือทาง
ฮารดแวรเปนสวนประกอบในการพัฒนาโปรแกรมดวย ซึง่ในกรณีของบอรด “ET-dsPIC30F2010” นั้น 
สามารถเลือกไดหลายแนวทาง ไมวาจะเปนการใชเครื่องมือสําหรับโปรแกรมขอมูลใหกับ MCU โดยใช
เครื่อง Programmer ที่สนบัสนุนการโปรแกรม MCU เบอร dsPIC30F2010 หรือใชชุดพัฒนาโปรแกรม
จําพวก In-Circuit Debugger ที่สนับสนุนการใชงานรวมกับ MCU เบอร dsPIC30F2010 ซึ่งทัง้ 2 แนวทาง
ขางตนที่กลาวมาแลวนั้น ทางผูใชจะตองเสียคาใชจายในการจัดหาเครื่องมือมาใชงานเอง แตอยางไรก็ตาม
ทางทมีงาน อีทีที ไดออกแบบวงจรของบอรด “ET-dsPIC30F2010” ใหสามารถทําการ Download Hex 
File จากคอมพิวเตอร PC โดยใชสัญญาณควบคุมจากพอรตขนาน หรือ พอรต Printer (LPT) โดยใชชุดสาย
ตอสัญญาณรุน “ET-CAB10PIN V2.0” เปนตัวกลางในการเชื่อมตอไดทันที โดยทีผู่ใชไมจําเปนตองจัดหา
เครื่องมืออ่ืนใดมาใชใหส้ินเปลืองอีก แตอยางไรก็ตามการพฒันาโปรแกรมของบอรดดวยวิธีการนี้ จะมี
ขอจํากัดอยู 2 ประการ เมื่อเทียบกับการใชชุด “In-Circuit Debugger” ในการพัฒนาโปรแกรม ก็คือ 

 ในปจจุบัน โปรแกรม MPLAB ยังไมยอมใหมีการเชือ่มตอเครื่องมือโปรแกรมอื่นๆที่ไมใช
เครื่องมือของ Microchips ผานทางเมนูคําสั่งของ MPLAB เอง ดังนัน้ผูใชจะตองแยกการ
ทํางานระหวางการพัฒนาโปรแกรม (เขียน Source โปรแกรม และ แปลเปน Hex File) 
และการ Download โปรแกรม (โปรแกรม Hex File ใหหนวยความจําของ MCU) 

 ไมสามารถตรวจสอบขอผิดพลาดของโปรแกรมในระหวางการสั่งให MCU ทํางานอยูได 
แตจะทําไดเพยีงการสั่งโปรแกรม (Download Hex File ให MCU) และ ดูผลการทํางาน
ของ MCU ในขณะที่ MCU ทํางานจริงๆ ซึ่งถาโปรแกรมที่เขียนขึ้นมาไมทาํงานหรือทํางาน
แลวเกิดความผิดพลาดขึ้น ผูใชจะตองใชความสามารถ ในการ คาดเดา และตรวจสอบหา
ขอผิดพลาดเหลานั้นจาก Source Code ของโปรแกรมเอง วานาจะมขีอผิดพลาดจากสวน
ใดของโปรแกรมบาง แลวจึงสั่งแกไขขอผิดพลาดนัน้ๆ พรอมกับส่ังแปลโปรแกรมซ้ําใหม 
แลวจึงสั่ง Download Hex File ให MCU ใหมเพื่อดูผลการทํางาน 
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การเขียนโปรแกรมใชงานกับบอรดโดยใช MPLAB C30 
 MPLAB C30 หรือ C30 Tools เปนโปรแกรมภาษาซ ีสําหรับใชแปลคําสั่งของ MCU ตระกูล dsPIC 
ซึ่งไดรับการพฒันาขึน้โดย Microchips เอง โดยขอกาํหนดและรายละเอียดของการเขียนโปรแกรมภาษาซี
นั้น จะไมกลาวถงึในทีน่ี้ดวย โดยถาผูใชตองการพฒันาโปรแกรมใหกับ dsPIC ดวยภาษาซ ี แตยังไมมี
ความรูเร่ืองการเขียนโปรแกรมภาษาซเีลยนั้นขอแนะนาํให หาหนงัสือที่อธิบายเกีย่วกับการเขียนโปรแกรม
ภาษาซีในสวนที่เปนมาตรฐานตามขอกําหนดของ “ANSI C” มาศึกษาใหเขาใจเสียกอน และสําหรับสวน
ของขอกําหนดปลีกยอยอื่นๆที่เปนของ MPLAB C30 เองก็สามารถอานเพิ่มเติมไดจากเอกสารและคูมือการ
ใชงานของ MPLAB C30 ที่ทาง Microchips จัดทําไวได โดยสามารถ Download จาก Website ของ 
Microchips หรือจาก Folder ของ “..\pic30_tools\docs” ที่ทาํการติดตั้งโปรแกรม MPLAB C30 ไวก็ได 
โดยในทีน่ี ้ จะขอกลาวแนะนําถงึเฉพาะสวนของการกาํหนดคาตวัเลือกในโปรแกรมเพื่อใชงานรวมกับบอรด 
“ET-dsPIC30F2010” เทานัน้ โดยในการที่จะใชงานโปรแกรม MPLAB C30 ในการเขียนโปรแกรมนั้น ผูใช
จําเปนตองทาํการติดตั้งโปรแกรมของ Microchips จํานวน 2 โปรแกรมดังนี้คือ 
 

 MPLAB IDE ซึ่งเปนโปรแกรม Text Editor ของ Microchips ซึ่งในปจจุบัน (ตุลาคม 2548) 
จะเปนรุน 7.21 แลวสามารถ Download มาใชงานไดฟรีจาก Web ของ Microchips 

 MPLAB C30 ซึ่งเปนตวัแปลภาษาซ ี (C Complier) ใหเปนรหัสคําสัง่ของ dsPIC โดยใน
ปจจุบัน(ตุลาคม 2548) จะเปน Version 1.33 ซึ่งตามปรกติแลวโปรแกรมชุดนี้จะตองซื้อ
มาใชงานเอง แตอยางไรกต็ามทาง Microchips เองมีรุนทดลองใชงานใหผูใชสามารถ 
Download มาใชงานไดเชนเดียวกนักับ MPLAB IDE 

 

โดยโปรแกรมทั้ง 2 ชุดนี ้ทางอีททีี ไดทาํการ Download มาจัดเตรียมไวใหในแผน CD-ROM ที่แถม
ไปกับบอรดของ “ET-dsPIC30F2010” ดวยอยูแลว โดยในการติดตัง้โปรแกรมนัน้ขอแนะนําใหผูใชทําการ
ติดตั้งโปรแกรมในชุดของ MPLAB IDE กอนเปนอนัดับแรก โดยขอแนะนาํใหติดตั้งโปรแกรมของ MPLAB 
IDE ไวตามคา Default ของโปรแกรมติดตั้งเลย คือ “C:\Program Files\Microchip\MPLAB IDE\" จะ
สะดวกตอการใชงานมากกวา ซึง่หลงัจากทําการติดตั้งโปรแกรม MPLAB IDE เสร็จเรียบรอยแลวในครั้งแรก
กอนการใชงานนัน้ตองสัง่ Restart เครื่องคอมพวิเตอรกอน หลังจากนัน้แลว MPLAB IDE จึงจะสามารถ
ทํางานไดโดยไมเกิดปญหา จากนั้นจงึทาํการติดตั้งโปรแกรม MPLAB C30 เปนลาํดับถัดไป โดยขอแนะนาํ
ใหทาํการติดตัง้โปรแกรมชุดนี้ไวตามคา Default ของการติดตั้งโปรแกรม คือ “C:\PIC30_TOOSL\” จะเกิด
ความสะดวกตอการใชงานมากที่สุด โดยเฉพาะในขัน้ตอนของการกาํหนดการเชื่อมโยงการทํางานระหวาง 
MPLAB IDE และ MPLAB C30 โดยในทีน่ี้จะขออธิบายโดยอางถงึตําแหนงการติดตั้งโปรแกรมดังที่กลาวไว
แลวขางตนเทานัน้ ซึ่งถาผูใชทําการสั่งติดตั้งโปรแกรมไวยังตําแหนง Folder ที่แตกตางไปจากนี้แลวขอใหทาํ
ความเขาใจและดัดแปลงวธิีการกาํหนดคาเองตามที่ติดตั้งโปรแกรมไวจริงๆดวย 
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การกําหนดการเชื่อมโยงการทํางานของ MPLAB IDE และ MPLAB C30 
 หลังจากทําการติดตั้งโปรแกรม MPLAB IDE และ MPLAB C30 เสร็จเรียบรอยแลว กอนที่จะ
เร่ิมตนใชงานโปรแกรม MPLAB C30 ไดนั้น ในครั้งแรกจะตองทาํการสั่งกาํหนดการเชื่อมโยงการทํางาน
ระหวาง MPLAB IDE และ MPLAB C30 ใหถูกตองเรียบรอยเสียกอน จงึจะสามารถเรียกใชงานโปรแกรม 
MPLAB C30 ผานทางโปรแกรม MPLAB IDE ไดอยางถกูตอง ทั้งนี้ก็เนื่องมาจากวา โปรแกรม MPLAB 
C30 นั้นจะเปนเพยีงตัวแปลคําสั่ง Text File ที่เปนภาษาซี (รวมทั้งภาษา Assembly) ใหเปนรหัสคําสั่งของ 
dsPIC ในรูปแบบของ Hex File เพียงอยางเดียวเทานัน้ สวนการเขียนโปรแกรม Source Code นั้นจะอาศัย
โปรแกรม MPLAB IDE เปนหลกั ซึ่งการสั่งแปลคําสั่งกจ็ะตองกระทําผานเมนูคําสัง่ของ MPLAB IDE ดวย 
เชนเดียวกนั ซึ่งตามปรกติแลว MPLAB IDE สามารถเชื่อมโยงการทาํงานรวมกับโปรแกรมอื่นๆไดอีกหลาย
โปรแกรม ไมไดใชงานเฉพาะกับ MPLAB C30 เพียงอยางเดียวเทานัน้ 
 โดยในชุดโปรแกรมของ MPLAB C30 หลงัจากติดตั้งโปรแกรมไปแลว โปรแกรม ใชงานตางๆจะถกู
เก็บไวใน Folder ชื่อ “C:\PIC30_TOOSL\BIN\” โดยจะมีโปรแกรมหลักๆที่ตองกําหนดการเชือ่มโยงการ
ทํางานกับ MPLAB IDE อยูดวยกนั 4 โปรแกรมดวยกันคือ 
 

 ไฟล “pic30-as.exe” ซึ่งเปนตวัโปรแกรมหลักสาํหรับใชในการสัง่งานในการแปลคําสั่ง
ภาษาแอสแซมบลี้ของ dsPIC (Assembler) 

 ไฟล “pic30-gcc.exe” ซึ่งเปนโปรแกรมหลักสาํหรับใชในการสั่งงานในการแปลคําสั่ง
ภาษาซีของ dsPIC (C Complier) 

 ไฟล “pic30-ld.exe” ซึ่งเปนโปรแกรมหลักสําหรับใชในการรวมไฟลตางๆเขาดวยกันเพื่อ
สรางเปน Hex File ของ dsPIC (Linker) 

 ไฟล “pic30-ar.exe” ซึ่งเปนโปรแกรมหลักในการจัดการกับ Library  
 

ซึ่งในอนัดับแรกกอนที่จะเริ่มตนเขาสูข้ันตอนของการใชงานนั้น จะตองทาํการกําหนดการเชื่อมโยง
คําสั่ง ระหวางโปรแกรม MPLAB IDE และ MPLAB C30 ใหเรียบรอยเสียกอน เพื่อทีโ่ปรแกรม MPLAB IDE 
จะไดทราบวาจะตองไปเรียกใชไฟลตางๆของ MPLAB C30 จากที่ใด โดยในการกาํหนดการเชื่อมโยง
โปรแกรมทั้ง 4 ใหสามารถใชงานกับ MPLAB IDE นั้นสามารถทําไดตามลําดับข้ันตอนตอไปนี ้

 
1. ส่ัง Run โปรแกรม MPLAB IDE โดยอาจเรียกจาก “ICON” ของโปรแกรมหรือเรียกผาน Windows 

จาก “Start → Program → PIC development Tools → Microchip MPLAB→ MPLAB”  
2. คลิกเมาสที่คําสั่ง “Project → Set Language Tools Locations..” แลวเลือกกาํหนดการใชงาน

โปรแกรม MPLAB IDE รวมกับโปรแกรม MPLAB C30 แลวเลือก “OK” ดังรูป 
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 เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่บริเวณตําแหนงเครื่องหมายบวก(+) ทีหนาคาํสั่งของ 
Microchip C30 Toolsuite (Supports 24F/30F/33F) ซึ่งจะไดผลดังรูป 
 

 
 
 ซึ่งจะเห็นไดวาในหัวขอ Microchip C30 Toolsuite (Supports 24F/30F/33F) นี้จะประกอบไปดวย
หัวขอยอยอกี 2 หัวขอ คือ Executables และ Default Search Patchs & Directories 

คลิกเมาสที่นี ่
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 ใหทาํการกาํหนดตําแหนงของไฟลของ MPLAB C30 ทีต่องการให MPLAB IDE เรียกใช ซึง่จะมอียู
ดวยกนัทัง้หมด 4 ไฟล โดยใหคลิกเมาส ที่บริเวณตําแหนงเครื่องหมายบวก (+) ทีห่นาหวัขอ Executables 
ซึ่งจะไดผลดังรูป 
 

 
 

 ในขั้นตอนนี้ใหทาํการกําหนดชื่อ และ ตําแหนง Folder ที่อยูของไฟลทั้ง 4 ซึ่งไดแก pic30-ar.exe, 
pic30-as.exe, pic30-gcc.exe และ pic30-ld.exe โดยใหทาํการคลิกเมาสที่รายการยอยของแตละหัวขอ
จนปรากฏแถบสีน้ําเงินทีห่ัวขอนั้นๆจากนัน้ก็ใหกําหนดตําแหนง Folder และชื่อของไฟล ใหกับแตละหัวขอ
จนครบทัง้ 4 หัวขอ โดยชื่อไฟลนั้นตองกาํหนดตามชื่อที่อยูในวงเล็บทายหวัขอ สวนตําแหนง Folder นั้น
ตามปรกติแลวจะอยูที่ “..\pic30_tools\bin\” เชน ถาติดตั้งโปรแกรม MPLAB C30 ไวตามที่แนะนาํไวใน
ตัวอยางคือ “c:\pic30_tools\” ไฟลที่ใชส่ัง Run (Execute) ทั้งหมดจะอยูที่ “c:\pic30_tools\bin\..” 
 โดยวิธีการกําหนดชื่อและตาํแหนง Folder ที่อยูของไฟล นัน้สามารถทําได 2 แบบ คือ การสั่งคลิก
เมาสที ่ “Browse…” เพื่อกําหนดตําแหนงที่อยูของ Folder ซึ่งเกบ็ Execute File ไว โดยใหชี้ไปที ่
“..\pic30_tools\bin\..” ตัวอยางเชน ถาตองการกาํหนดชื่อ Execute File และตําแหนง Folder ของไฟล
สําหรับ LIB30 Archiver (pic30-ar.exe) ตองกําหนดชื่อไฟลเปน “pic30-ar.exe” โดยใหคลิกเมาสที่ 
“Browse…” แลวชี้ไปที่ “c:\pic30_tools\bin\pic30-ar.exe” หรืออาจใชวิธีการพิมพ ชื่อ Folder ในชอง 
Location เองเปน “c:\pic30_tools\bin\pic30-ar.exe” ก็ได (ถาติดตั้งโปรแกรมไวตางจากนี้ตองกาํหนดให
ตรงกับที่ติดตัง้ไวจริงดวย) 
 โดยในขั้นตอนนี้ ใหกําหนดชือ่และตําแหนง Folder ของ Execute File ใหครบทั้ง 4 หวัขอ ดวย ดัง
รูปในตัวอยางตอไปนี้ 

คลิกเมาสที่นี ่



คูมือการใชงานบอรด ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP 

ETT CO.,LTD -14- WWW.ETT.CO.TH 
 

 
 

รูปแสดง ลักษณะการกาํหนด Execute File ของ LIB30 Archiver 
 
↓ 
 

 
 

รูปแสดง ลักษณะการกาํหนด Execute File ของ MPLAB ASM30 Assembler 
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รูปแสดง ลักษณะการกาํหนด Execute File ของ MPLAB C30 C Complier 
 
↓ 
 

 
 

รูปแสดง ลักษณะการกาํหนด Execute File ของ MPLAB LINK30 Object Linker 
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 เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่บริเวณตําแหนงเครื่องหมายบวก(+) ทีหนาคาํสั่งของ 
Default Search Patchs & Directories ซึ่งจะไดผลดังรูป 
 

 
 

เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่ “Assembler Include Search Path, $(AINDIR)” จน
ปรากฏแถบสีน้ําเงินดงัรูป แลวจึงคลิกเมาสที่ “Browse…” เพื่อกาํหนดตําแหนงที่อยูของ Folder ซึ่งเก็บ 
Source Code ภาษา Assembly ไว โดยใหชี้ไปที ่“..\pic30_tools\support\gld” หรืออาจใชวิธีการพิมพ ชื่อ 
Folder ในชอง Location เองก็ไดดังรูป (ถาติดตั้งโปรแกรมไวตางจากนีต้องกําหนดใหตรงดวย) 
 

 
 

คลิกเมาสที่นี ่
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เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่ “Include Search Path, $(INCDIR)” จนปรากฏแถบสีน้ํา
เงินดงัรูป แลวจึงคลิกเมาสที่ “Browse…” เพื่อกําหนดตําแหนงทีอ่ยูของ Folder ซึ่งเก็บ Header File ไว 
โดยในการกําหนดตําแหนง Folder นั้นใหชี้ไปที ่ “..\pic30_tools\support\h” หรืออาจใชวิธกีารพิมพ ชื่อ 
Folder ในชอง Location เองก็ไดดังรูป (ถาติดตั้งโปรแกรมไวตางจากนีต้องกําหนดใหตรงดวย) 
 

 
 

เมื่อมาถงึขั้นตอนนี้ใหทาํการคลิกเมาสที่ “Library Search Path, $(LIBDIR)” จนปรากฏแถบสีน้าํ
เงินดงัรูป แลวจึงคลิกเมาสที ่“Browse…” เพื่อกําหนดตําแหนงที่อยูของ Folder ซึ่งเก็บ Library File ไว โดย
ในการกาํหนดตําแหนง Folder นัน้ใหชี้ไปที่ “..\pic30_tools\lib” หรืออาจใชวิธกีารพิมพ ชื่อ Folder ในชอง 
Location เองก็ไดดังรูป (ถาติดตั้งโปรแกรมไวตางจากนีต้องกําหนดใหตรงดวย) 
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ตัวอยางการสรางโปรแกรมภาษาซีของ MPLAB C30 
เมื่อทําการกาํหนดการเชื่อมโยงคําสัง่ระหวาง MPLAB IDE และ MPLAB C30 เปนที่เรียบรอยแลว 

ตอจากนี้ไป ผูใชก็สามารถทาํการเรียกใชงานโปรแกรม MPLAB C30 ผานทางโปรแกรม MPLAB IDE ได
แลว โดยคาตัวเลือกตางๆที่ไดกําหนดไวแลวนั้นจะถกูเก็บไวใน Configuration ของโปรแกรมตลอดไป 
จนกวาจะมีการสั่งเปลี่ยนแปลงใหม ซึ่งในที่นี้จะขอยกตวัอยางการเขียนโปรแกรมภาษาซี ของ MPLAB C30 
สัก 1 ตัวอยางพอเปนแนวทางใหผูใชทาํความเขาใจ โดยมีลําดับข้ันตอนดังนี ้

1. ส่ัง Run Program ของ MPLAB IDE ข้ึนมา จากนัน้ก็ส่ังสรางไฟลใหมข้ึนมา 1 ไฟล สําหรับเขียน 
Source Code ภาษาซี โดยใชคําสั่ง “File → New” จากนัน้ใหทําการพิมพ Source Code ภาษาซี
ใน Work Sheet ของโปรแกรม MPLAB IDE ดังตัวอยาง 

 

 
 
 
2. ทําการสั่งบนัทึกไฟลที่เขียนขึ้นใหเปน Text File ภาษาซี โดยใหทดลองกําหนดชื่อเปน “main.c” 

แลวสั่งบันทึกไวใน Folder ชื่อ “c:\pic30_tools\examples\demo1\main.c” โดยในทีน่ี้ใหใชคําสั่ง 
“File → Save As…” แลวสราง Folder ชื่อ demo1 ไวภายใต Folder ของ examples อีกชั้นหนึ่ง 
แลว กาํหนดชือ่เปน “main.c” แลวเลือก “Save” ดังรูป 
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 ซึ่งจะเห็นวาเมือ่ทําการสั่งบนัทึกไฟลเปน “main.c” ไปแลว กลุมของตวัอักษรตางๆทีไ่ดพิมพไว จะ
ถูกจัดแบงกลุม โดยใชสีในการแสดงผลทีแ่ตกตางกนัไปตามหนาที่ของกลุมตัวอกัษร เชน กลุมตัวอักษรที่ใช
เปนคําอธิบาย (Comment) กลุมตัวอักษรที่เปนคาํสั่ง และกลุมตัวอักษรที่เปนตัวแปรตางๆ ซึง่จดุนี้เปนขอดี
ของ MPLAB IDE ที่สามารถแยกการแสดงผลกลุมตัวอักษรตามหนาทีก่ารใชงานได ทําใหเราสามารถอาน
โปรแกรมไดงายและสะดวกมากยิง่ขึ้นดงัรูป 
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#include <p30f2010.h>             // dsPIC30F2010 MPU Register 
 
_FOSC(CSW_FSCM_ON & XT_PLL16);  // Enable Clock Switching 
        // Enable Fail-Self Clock 
        //   Clock Source = Primary XT  
        // Enable PLL x 16 
_FWDT(WDT_OFF);    // Disable Watchdog  
_FBORPOR(PBOR_ON & BORV_45 &   // Enable Brown-Out = 4.5V 
      PWRT_64 &     // Power ON = 64mS          
      MCLR_EN);    // Enable MCLR    
_FGS(CODE_PROT_OFF);   // Code Protect OFF 
 
void delay_led(unsigned long int); // Delay Time Function 
 
int main(void) 
{   
  TRISBbits.TRISB0 = 0;   // Config RB0 = Output 
   
  while(1)      //  Loop Continue 
  { 
    LATBbits.LATB0 = !LATBbits.LATB0;  // Toggle Output RB0  
 delay_led(1000000);      // Display LED Delay 
  }    
}    
 
void delay_led(unsigned long int count1) 
{ 
  while(count1 > 0) {count1--;}  // Loop Decrease Counter  
} 

 
แสดง ตัวอยาง Source Code สําหรับใชทดลองการทํางาน 

 
 สําหรับตัวอยางนี้จะเปนการสั่งใหใชพอรต RB0 ทําหนาที่เปน Output ขับ LED ใหติดและดับ
สลับกันไปไมรูจบในลักษณะของไฟกระพรบิ ซึ่งวิธีการทดสอบการทาํงานของโปรแกรมนี้ โดยใชกับบอรด 
ET-dsPIC30F2010 นั้นทําไดโดยตอสัญญาณจาก RB0 เขากับ LED Output ของบอรด โดยจะเห็นผลการ
ทํางานของโปรแกรมแกรม คือ LED จะกระพริบ ติดและดับอยางตอเนื่องตลอดเวลา 
 สวนที่นาสนในของโปรแกรมคือบรรทัดคําสั่ง “_FOSC(CSW_FSCM_ON & XT_PLL16);” ของ
โปรแกรมไปจนถึงบรรทัดคําสั่ง “_FGS(CODE_PROT_OFF);” โดยในสวนนี้เปนสวนของการกําหนดคา 
Configuration ของ MCU เบอร “dsPIC30F2010” เพื่อใชกับบอรด “ET-dsPIC30F2010”  
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3. ทําการสราง Project File เพื่อใชส่ังผนวกไฟลตางๆ ที่เกี่ยวของเขาดวยกนั ทั้งนี้เนื่องมาจากวา
ภาษาซีของ MPLAB C30 นั้น ถูกออกแบบใหมีความออนตัวในการใชงาน ดังนั้นจึงมีการจัดสราง
และแบงแยกไฟลออกเปนหลายๆไฟลตามหนาที่การใชงาน เพื่อใหผูใชสามารถเรียกไฟลตางๆ
เหลานั้นเขามาใชงานรวมกบั Source Code  ที่เขยีนขึ้นมาไดไดงาย โดยไมตองเสียเวลาเขยีน 
Source Code เองทั้งหมด ซึ่งจะทาํใหผูใชสามารถลดเวลาในการเขียนโปรแกรมไปไดเปนอยาง
มากเนื่องจากเพียงแตทําการสั่งผนวกไฟลที่ทาง MPLAB C30 สรางเตรียมไวให เขากับ Source 
Code ที่ผูใชเขียนขึ้นใหมแลวสั่งแปลโปรแกรมก็จะไดไฟลที่มีความสมบูรณตอการใชงานแลว โดย
จากตัวอยาง Source Code ที่ไดทดลองเขียนไปแลวในขางตน ก็เชนเดียวกัน จะเห็นไดวามีการสั่ง
ผนวกไฟลชื่อ “p30f2010.h” เขามาใชงานดวย ซึง่ทาํใหไมตองเสียเวลาไปสัง่ประกาศชื่อและ
ตําแหนงรีจิสเตอรตางๆของ dsPIC30F2010 ใหเสียเวลา แตสามารถอางถึงชื่อของรีจิสเตอรตางๆ
ในโปรแกรมไดทันที โดยวิธกีารกําหนดคุณสมบัติของ Project File มีดังนี ้

 ส่ังกําหนดคุณสมบัติของ project File โดยใชคําสั่ง “Project → Project Wizard…” ซึง่
จะไดผลดังรูป จากนัน้ใหเลอืก “Next >” เพื่อไปยังขั้นตอนตอไป 

 

  
 
 หลังจากเลือก “Next >” แลว โปรแกรมจะรอใหกาํหนดเบอรของ MCU ที่จะใชงานรวมกบั
โปรแกรมที่เขยีนขึ้น ซึ่งใหเลือกกําหนดเปน “dsPIC30F2010” จากนั้นเลือก “Next >” เพื่อขามไปทํางานยงั
ข้ันตอนตอไปดังรูป 
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 ในขั้นตอนนี้จะเปนการเลือกวาจะใชโปรแกรมชุดใดในการแปลคําสั่ง เนื่องจาก MPLAB IDE 
สามารถใชงานไดกับชุดโปรแกรมตางๆมากมายหลายโปรแกรม ซึ่งในทีน่ี้ใหเลือกกาํหนดใชโปรแกรม ของ 
MPLAB C30 โดยการเลือกกําหนดตัวเลือกของ “Active Toolsuite” ใหเปนของ MPLAB C30 โดยกําหนด
ตัวเลือกเปน “Microchip C30 Toolsuite (Supports 24F/30F/33F)” ดังรูป แลวเลือก “Next >” 
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ในขั้นตอนนี้จะเปนการ กาํหนดชื่อ Project และตําแหนง Folder ที่จะใชเก็บไฟลตางๆที่ไดจากการ
ทํางานของ Project โดยใหกาํหนดชื่อเปน “LED_BLINK” แลวกาํหนดตําแหนง Folder เปน DEMO1 โดย
กําหนดไวภายใต Folder ชื่อ examples ของ MPLAB C30 ดังรูป แลวเลือก “Next >” 

 

 
 

 ในขั้นตอนนี้จะเปนการสั่งผนวกไฟลตางๆเขาไวดวยกนัภายใตชื่อ Project ของ LED_BLINK โดย
ใหทาํการสัง่ผนวกไฟลทัง้หมด 3 ไฟลเขาไวใน Project ดังนี ้

 ส่ังผนวกไฟลชือ่ “main.c” ซึ่งเปน Source Code ที่เราไดเขียนและสั่งบันทึกไวแลวใน
ข้ันตอนที่ผานมาโดยเก็บอยูใน c:\pic0_tools\examples\demo1\main.c” 

 ส่ังผนวกไฟลชือ่ “libp30f2010a2.a” ซึ่งเปน Library ที่ใชกับ MCU เบอร dsPIC30F2010 
ซึ่งทาง MPLAB C30 ไดจัดสรางเตรียมไวใหใชงาน โดยถาติดตั้งโปรแกรมตามตัวอยาง
ไฟลดังกลาวจะเก็บอยูใน “c:\pic30_tools\lib\libp30f2010a2.a” 

 ส่ังผนวกไฟลชือ่ “p30f2010a2.gld” ซึ่งเปน Script File ของ dsPIC30F2010 ที่ทาง 
MPLAB C30 สรางเตรียมไวให โดยถาตดิตั้งโปรแกรมตามตัวอยางไฟลดังกลาวจะเก็บอยู
ใน “c:\pic30_tools\support\gld\p30f2010a2.gld” 

 
โดยในการสั่งผนวกไฟลทัง้ 3 ดังกลาวใหทาํการคลิกเมาสไปยงั “ICON” ของไฟลจากตาํแหนง 

Folder ที่กลาวไวในขางตนที่ผานมาแลวเลือก “Add >>” จนชื่อไฟลดังกลาวไปปรากฏอยูทีก่รอบหนาตาง
ดานขวาของโปรแกรม ซึ่งใหเลือกทําตามวิธีการนี้จนสามารถสั่ง “Add” ไฟลไดครบทั้ง 3 ไฟล แลวเลือก 
“Next >” เพื่อไปยังขั้นตอนตอไปดังรูป 
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 เมื่อส่ังผนวกไฟลทัง้หมดเขากับ Project ไฟลที่สรางขึ้นเปนที่เรียบรอยแลว โปรแกรมจะรายงานผล 
โดยแสดงคาพารามิเตอรตางๆที่ไดกําหนดไวแลวใหทราบดังรูป ใหเลือก “Finish” เปนอันเสร็จข้ันตอนของ
การสราง Project File ของ BLINK_LED  
 

 
 
 

 ซึ่งหลงัจากกาํหนดคาตางๆใหกับ Project File เปนที่เรียบรอยแลว ผูใชก็สามารถทําการสั่งแปล
คําสั่งของโปรแกรม “main.c” ที่เขียนขึ้นไดทันที โดยใชคําสั่ง “Project → Build All” ซึ่งจะทําใหไดไฟล 
Output มีชื่อเดียวกับ Project File ที่สรางไวแตมีนามสกุลเปน HEX ซึ่งจากตัวอยาง Project นี้เมื่อส่ังแปล
โปรแกรมแลวถาไมเกิดขอผิดพลาดใดๆจะได Output ไฟลชื่อ “LED_BLINK.HEX” โดยไฟลดังกลาวจะถูก
สรางและเก็บไวในตําแหนง Folder ของ Project คือ  “c:\pic30_tols\examples\demo1\led_blink.hex” 
โดยผูใชสามารถสั่ง Download Hex File ชื่อ “LED_BLINK.HEX” นี้ใหกับบอรด “ET-dsPIC30F2010” เพื่อ
ทดสอบการทาํงานไดทนัท ี 
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การ Download HEX File ใหบอรดดวยโปรแกรม “WinPic800” 
 

 การ Download Hex File ใหกับบอรดนั้น ในปจจบัุน (พฤศจิกายน 2548) สามารถเลือกใช
โปรแกรม “WinPic800” หรือ “melabs Programmer” ก็ไดตามตองการ โดยไมวาจะเลือกใชโปรแกรมชุดใด 
เปนโปรแกรมสั่ง  Download ก็สามารถใชงานไดเหมือนกนัทุกประการ เพียงแตวธิีการสั่งงานโปรแกรมอาจ
มีรายละเอยีดและหนาตาของโปรแกรมทีแ่ตกตางกนัไปบาง แตไมวาจะเลือกใชโปรแกรมชุดใดในการ
ส่ังงานก็ตามจาํเปนจะตองใชชุด “ET-CAP10PIN V2.0” เปนตัวกลางในการเชื่อมตอสัญญาณจากพอรต
ขนาน (LPT) ของคอมพิวเตอร PC กับบอรด โดยในการ Download นั้นจะตองใช Adapter จายไฟใหกับ
บอรดดวยคาแรงดันไมตํ่ากวา 14V ไมเชนนัน้แลวจะไมสามารถสั่ง Download HEX File ใหกับ MCU ได  

สําหรับโปรแกรม “WinPic800” นั้น เปนโปรแกรมประเภท “Free Ware” ใชสําหรบั Download 
Hex File ใหกบั MCU ตระกูล PIC และ dsPIC พัฒนาข้ึนโดย “Sisco Benach Font” ซึ่งทางอทีีท ีไดรวม
สนับสนนุคาใชจายใหกับทางผูพัฒนาโปรแกรม เพื่อขอสิทธิ์ในการนําโปรแกรมดงักลาวมาแจกจายเพื่อใช
งานกับสินคาของทางอีททีดีวยแลว ซึ่งผูใชสามารถทําการ Download มาใชงานไดฟรีโดยไมเสียคาใชจาย
ใดๆ โดยโปรแกรมตัวนี้ในปจจุบันไดรับการปรับปรุงมาอยางตอเนื่องเปนลาํดับจนถึงรุนลาสุดคือ “3.56” 
แลว ซึ่งในรุนนี้สามารถใชงานไดกับ MCU ตระกูล PIC และ dsPIC ของ Microchips ไดมากมายหลาย
เบอรรวมทัง้เบอร “dsPIC30F2010” ดวย โดยขั้นตอนของการ Download HEX File ดวยโปรแกรม 
“WinPic800” มีลําดับข้ันตอนเปนดงันี ้

1. ติดตั้งโปรแกรม “WinPic800” ในเครื่องคอมพิวเตอรใหเรียบรอยพรอมใชงาน 
2. เขียนโปรแกรมและแปลคําสั่งของโปรแกรมที่เขียนใหเปน “Hex File” ซึ่งวิธกีารเขียนโปรแกรมและ

การสั่งแปลโปรแกรมจะไมขอกลาวถึงในทีน่ี้ดวย ทัง้นี้ข้ึนอยูกับผูใชวาจะเลือกใชภาษาอะไรในการ
พัฒนาโปรแกรม และจะเลอืกใชโปรแกรม Assembler หรือ Complier ตัวใดเปนตัวแปลคําสั่งให
แตทายที่สุดแลวไมวาจะเขยีนโปรแกรมดวยภาษาอะไร หรือ ใชโปรแกรมใด เปนตวัแปลคําสั่งกจ็ะ
ไดไฟล Output ที่จะนํามาใชในการสัง่งาน MCU เหมอืนๆกันในรูปแบบของ “Hex File” ซึ่งในที่นี้
จะขอกลาวถึงเพียงวิธกีารสัง่ Download Hex File ใหกบัหนวยความจํา Flash ของ MCU ภายใน
บอรด “ET-dsPIC30F2010” เทานัน้ สวนวิธีการซึ่งจะทาํใหได Hex File มานั้นจะไมขอกลาวถงึ 

3. ติดตั้งชุด “ET-CAP10PIN V2.0” เขากับพอรตขนาน (LPT Port หรือ Printer Port) ของเครื่อง
คอมพิวเตอร PC เพื่อใชในการสั่ง Download Hex File ดวยโปรแกรม “WinPIc800” 

4. ตอสายแพรขนาด 10 PIN จากขั้วตอ “ET-EMPIC” ของบอรด “ET-CAP10PIN V2.0” เขากับข้ัวตอ
สําหรับ Download ของบอรด “ET-dsPIC30F2010” ที่ตําแหนง “DOWNLOAD(ET-EMPIC)” 

5. เลือกสวิตชสําหรับเลือกโหมดการทํางานของบอรด (RUN/PROG) ใหอยูในโหมด Program โดยให
เลือกสวิตชไวทางดาน “PROG” 
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6. ทําการจายไฟใหกับบอรด “ET-dsPIC30F2010” ซึ่งจะตองใชแหลงจายไฟซึง่มีคาแรงดันไมนอย
กวา 14V ดวยถาแหลงจายไฟมีคาแรงดนัต่ํากวานี้จะไมสามารถสัง่โปรแกรมไดสําเร็จ 

7. ส่ัง Run Program ของ “WinPIC800” เพือ่เร่ิมตนขั้นตอนของการ Download HEX File 
 

 
 

รูปแสดง ลักษณะของโปรแกรม “WinPic800” 
 

8. ถายงัไมไดกําหนดคาตวัเลือกใหกับโปรแกรม “WinPic800” เพื่อใชส่ัง Download Hex File ใหกบั
MCU เบอร “dsPIC30F2010” รวมกับระบบฮารดแวรของ อีทีท ี มากอน ใหทาํการกาํหนดคา
ตัวเลือกของโปรแกรมสําหรบัใชงานรวมกบั MCU ตระกูล dsPIC ใหเรียบรอยดังนี ้

 กําหนดภาษาที่จะใชในการสั่งงานโปรแกรม โดยขอแนะนําใหเลือกเปนภาษาอังกฤษ โดย
ใหคลิกเมาสทีเ่มนูคําสัง่ Language แลวเลอืก English ดังรูป 
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 ทําการกําหนดรูปแบบการเชื่อมตอทางฮารดแวรของบอรดใหถูกตอง โดยการคลิกเมาสที่
เมนูคําสัง่ “Settings → Hardware” โดยในกรณีที่ใชงานโปรแกรม “WinPIC800” รวมกับ
บอรด “ET-dsPIC30F2010” โดยใชสาย Download ของ อีททีี รุน “ET-CAP10PIN V2.0” 
ใหกําหนดรูปแบบการเชื่อมตอทางฮารดแวรเปน “ETT ET-dsPIC30F2010” หรืออาจเลือก
เปน “ETT-HIGH VPP ICSP” ก็ไดตามตองการ สวน LPT นัน้ใหกาํหนดตามความเปนจริง 
ซึ่งปรกติจะเปน “LPT1” แลวเลือก “Apply edits” ดังรูป 

 

 
 

 ทําการกําหนดเงื่อนไขการทํางานของโปรแกรมวาตองการใหโปรแกรมทํางานตามลําดับ
ข้ันตอนอยางไรบาง โดยการคลิกเมาสที่เมนูคําสั่ง “Settings → Software” ดังรูป 

 
ที่ Tab ของ Program ใหเลือก 

 Verify after programming 
 

ที่ Tab ของ Device ใหเลอืก 
 Use user device selection 
 Detect and  select device at startup 

 
ที่ Tab ของ Hex ใหเลือก 

 Update File before programming 
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 ↓ 

 
↓ 

 
 

 ซึ่งในขัน้ตอนนี้อาจเลือกทกุขั้นตอนเลย แตถาเหน็วาเลอืกทุกขัน้ตอนแลวทําใหเสียเวลาใน
การ Download นานเกินไปก็อาจลดหวัขอที่ไมจําเปน เชน Verify after programming ออกก็ได
จากนั้นใหเลือกที่ “Accept” เพื่อบันทึกคาตัวเลือกนี้ไวใชงานกับโปรแกรมตลอดไป 
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9. หลังจากทําการกําหนดคาตวัเลือกตางๆใหกับโปรแกรมเปนทีเ่รียบรอยแลว หลงัจากนีเ้ปนตนไปก็
สามารถสัง่งานโปรแกรม “WinPic800” ไดตามตองการ โดยคาตัวเลอืกที่กาํหนดไวจะถกูบันทึกไว
เพื่อใชเปนเงื่อนไขในการทํางานของโปรแกรมตลอดไปจนกวาจะมีการสั่งเปลี่ยนแปลงใหม ซึ่งนัน่ก็
หมายความวาในครั้งตอๆไปถาตองการใชงานโปรแกรมรวมกับบอรด “ET-dsPIC30F2010” อีกก็
จะไมจําเปนตองเขาไปกําหนดคาตัวเลือกในโปรแกรมใหมใหเสียเวลาอีก สามารถขามขั้นตอนของ
การกําหนดคาตัวเลือก (ขอ 8) ไปส่ังงานโปรแกรมไดทันทีเลย โดยวิธีการสําหรับส่ังงานโปรแกรม 
“WinPic800” นั้นสามารถทาํได 2 วิธ ี คือการสั่งงานผานทาง เมนูคําสั่ง หรือส่ังงานผาน “Button” 
คําสั่งตางๆ ของโปรแกรมไดตามตองการ ดังตัวอยาง 

 ส่ัง Open Hex File เพื่อใชในการ Download ใหกับ MCU โดยสามารถสั่งผานเมนคํูาสั่ง
ของ “File → Open” หรือคลิกเมาสที ่Button คําสั่ง  แลวเลือกกําหนดชื่อและที่อยู
ของ Hex File ที่ตองการจะใช Download ตามตองการ 

 ส่ังตรวจสอบการเชื่อมตอทางฮารดแวรกับ MCU โดยสามารถสั่งงานผานเมนูคําสั่งของ 
“Device Detect PIC” หรือคลิกเมาสที่ Button คําสั่ง  ซึ่งโปรแกรมจะทาํการอาน
รหัส ID Code ของ MCU พรอมกับแสดงชื่อเบอรของ MCU ที่ตรวจพบใหทราบ โดยถา
การทาํงานถูกตองในกรณีทีใ่ชกับบอรด “ET-dsPIC30F2010” จะตองไดผลดังรูป 

 

 
 

 ถาการตรวจสอบเบอร MCU เกิดความผดิพลาด โดยถาโปรแกรมแสดงเบอรไมถูกตอง ให
ลองตรวจสอบตําแหนงสวิตชเลือกการทํางาน “PROG/RUN” วาถูกเลือกไวทางดาน “PROG” 
ถูกตองแลวหรอืยัง สายสัญญาณตางๆตอ แนน สนทิ ดีหรือยัง คาแรงดันของแหลงจายไฟที่ใช
มีคาถูกตองหรือไม (14V-18V) รวมทั้งการกาํหนดรูปแบบการเชื่อมตอทางฮารดแวรของ
โปรแกรมกําหนดไวเปน “ETT-HIGH VPP ICSP” หรือ “ETT ET-dsPIC30F2010” ถูกตอง
หรือไม ถาทุกอยางเรยีบรอยแลวลองทําซ้าํดูอีกครั้งหนึ่งจนไดคาเบอร MCU ที่ถูกตอง 
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 ตรวจสอบคา Configuration ของ “dsPIC30F2010” วากาํหนดไวถกูตองหรือไม โดยใน
กรณีที่ใชงานกับบอรด “ET-dsPIC30F2010” นั้นตองกําหนดคา Configuration ของ 
MCU ในสวนของการเลือกกําหนดคาความถี่ของสัญญาณนาฬิกา และการทาํงานของ
วงจร Watchdog ดวยคาตวัเลือกดังนี ้ 

 OSC Source on POR ใหเลือกกําหนดเปน Primary ซึ่งเปนการเลือกกําหนดให 
MCU เลือกใชสัญญาณนาฬกิาจากวงจร Primary Clock Source 

 Primary Oscillator ใหเลือกเปน XT w/PLL 16X - XT crystal oscillator mode 
with 16X PLL ซึ่งเปนการเลือกสัญญาณนาฬิกาของ Primary Clock Source 
จากตัวกําเนิดความถี ่ XTAL คา 4-10MHz ภายนอกซึ่งตอไวที่ขา OSC1,OSC2 
พรอมกับเปดการทาํงานของวงจรคูณความถี่ไวที ่16 เทาของความถี ่XTAL ดวย 

 FWDTEN ตองไมเลือกเพื่อเปนการสัง่ปดการทาํงานของ Watchdog 
สวนคา Configuration อ่ืนๆ สามารถเลอืกกําหนดไดเองตามตองการ ซึ่งตามปรกติ

แลวคาของ Configuration นี้จะถกูกาํหนดคาไวในขั้นตอนของการพฒันาโปรแกรมอยูแลว
โดยเมื่อส่ังแปลโปรแกรมเปน HEX นั้นคา Configuration จะฝงอยูใน HEX File ดวยเสมอ
แตอยางไรก็ตามถาผูใชไมไดกําหนดคาทีถู่กตองใหกับ Configuration ไวดวย ในขั้นตอน
ของการพฒันาโปรแกรมก็อาจทาํใหคา Configuration มีคาไมถูกตองตามตองการ ดังนัน้
จะตองแกไขคาตัวเลือกของ Configuration ใหถูกตองกอนสั่ง Program โดยผูใชสามารถ
ตรวจสอบคาของ Configuration ในปจจุบันไดจากหนาจอโปรแกรม โดยการคลิกเมาส
เลือกไปที่แท็ปของ “Setting” ดังรูป 

 

 
 

รูปแสดงการกาํหนดคา Configuration สําหรับบอรด “ET-dsPIC30F2010” 
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 ส่ัง Download Hex File ใหกับหนวยความจํา Flash ของ MCU ในบอรด โดยสามารสัง่
ผานเมนูคําสัง่ของ “Device → Program All”  หรือคลิกเมาสที ่Button คําสั่ง  ซึ่ง
หลังจากขั้นตอนนี้เสร็จส้ินลง ถาไมเกิดความผิดพลาดใดๆ เมื่อเลือกสวิตชกาํหนดโหมด
การทาํงานของบอรดไปยังดาน “RUN” จะเห็นวา MCU จะเริ่มตนทํางานทันท ี

 

 
↓ 

 
↓ 

 
 

รูปแสดง ลําดับขั้นการทาํงานของการสั่งงานดวยคําสั่ง “Program All” 



คูมือการใชงานบอรด ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP 

ETT CO.,LTD -33- WWW.ETT.CO.TH 
 

การ Download HEX File ใหบอรดดวยโปรแกรม “melabs Programmer” 
 

 สําหรับโปรแกรม “melabs Programmer” ก็เปนอกีโปรแกรมหนึง่ซึง่สามารถนํามาใชงานในการสัง่ 
Download Hex File ใหกับ MCU ของบอรด “ET-dsPIC30F2010” ไดดีเชนเดียวกนักับ “WinPic800” โดย
โปรแกรม “melbas Programmer” เปนของ “micro Engineering Labs, Inc.” ซึ่งเปนผูพัฒนาโปรแกรม 
PIC Basic Pro Complier สําหรับ MCU ตระกูล PIC ที่หลายคนรูจกักันเปนอยางนี้มาแลว โดยโปรแกรม 
“melbas Programmer” รุน Beta สามารถ Download มาใชไดฟรีโดยไมเสียคาใชจายเชนเดียวกัน สําหรับ
วิธีการใชงานโปรแกรม “melbas Programmer” รวมกับบอรด “ET-dsPIC30F2010” มีดังตอไปนี ้
 

1. ติดตั้งโปรแกรม “melbas Programmer” ในเครื่องคอมพวิเตอรใหเรียบรอยพรอมใชงาน 
2. เขียนโปรแกรมและแปลคําสั่งของโปรแกรมที่เขียนใหเปน “Hex File” ซึ่งวิธกีารเขียนโปรแกรมและ

การสั่งแปลโปรแกรมจะไมขอกลาวถึงในทีน่ี้ดวย ทัง้นี้ข้ึนอยูกับผูใชวาจะเลือกใชภาษาอะไรในการ
พัฒนาโปรแกรม และจะเลอืกใชโปรแกรม Assembler หรือ Complier ตัวใดเปนตัวแปลคําสั่งให
แตทายที่สุดแลวไมวาจะเขยีนโปรแกรมดวยภาษาอะไร หรือ ใชโปรแกรมใด เปนตวัแปลคําสั่งกจ็ะ
ไดไฟล Output ที่จะนํามาใชในการสัง่งาน MCU เหมอืนๆกันในรูปแบบของ “Hex File” ซึ่งในที่นี้
จะขอกลาวถึงเพียงวิธกีารสัง่ Download Hex File ใหกบัหนวยความจํา Flash ของ MCU ภายใน
บอรด “ET-dsPIC30F2010” เทานัน้ สวนวิธีการซึ่งจะทาํใหได Hex File มานั้นจะไมขอกลาวถงึ 

3. ติดตั้งชุด “ET-CAP10PIN V2.0” เขากับพอรตขนาน (LPT Port หรือ Printer Port) ของเครื่อง
คอมพิวเตอร PC เพื่อใชในการสั่ง Download Hex File ดวยโปรแกรม “melbas Programmer” 

4. ตอสายแพรขนาด 10 PIN จากขั้วตอ “ET-EMPIC” ของบอรด “ET-CAP10PIN V2.0” เขากับข้ัวตอ
สําหรับ Download ของบอรด “ET-dsPIC30F2010” ที่ตําแหนง “DOWNLOAD(ET-EMPIC)” 

5. เลือกสวิตชสําหรับเลือกโหมดการทํางานของบอรด (RUN/PROG) ใหอยูในโหมด Program โดยให
เลือกสวิตชไวทางดาน “PROG” 

6. ทําการจายไฟใหกับบอรด “ET-dsPIC30F2010” ซึ่งจะตองใชแหลงจายไฟซึง่มีคาแรงดันไมนอย
กวา 14V ดวยถาแหลงจายไฟมีคาแรงดนัต่ํากวานี้จะไมสามารถสัง่โปรแกรมไดสําเร็จ 

7. ส่ัง Run Program ของ “melabs Programmer” เพื่อเร่ิมตนขั้นตอนของการ Download HEX File 
ซึงจะไดผลดังรูป 

 

 
 

รูปแสดง ลักษณะของโปรแกรม “melabs Programmer” 
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8. ถายงัไมไดกําหนดคาตวัเลือกใหกับโปรแกรม “melabs Programmer” เพื่อใชส่ัง Download Hex 
File ใหกับ MCU เบอร “dsPIC30F2010” รวมกับระบบฮารดแวรของ อีททีี มากอน ใหทําการ
กําหนดคาตัวเลือกของโปรแกรมสําหรับใชงานรวมกบั MCU ตระกูล dsPIC ใหเรียบรอยดังนี ้

 กําหนดการทาํงานของคาํสัง่ โดยใหเลือกเมาสทีเ่มนูคําสั่ง “Options” แลวเลือกคลิกเมาส
หนาตัวเลือกคาํสั่งตางๆจนปรากฏเครื่องหมาย (√) หนาคําสั่งดังนี ้

 Update Configuration From File เปนการกําหนดใหโปรแกรมทําการ
เปลี่ยนแปลงคาตัวเลือกของ Configuration ตามคาที่กาํหนดไวจาก Hex File 
ที่ส่ัง Open มาใชงานในโปรแกรม 

 Erase Before Programming เปนการสัง่ใหโปรแกรมทําการสั่งลบขอมูลจาก
หนวยความจาํของ MCU กอนสั่งโปรแกรมโดยอัตโนมัติ ซึ่งจะทําใหเราไมตอง
เสียเวลาไปสั่งลบขอมูลดวยคําสั่ง Erase เองใหเสียเวลา 

 Verify After Programming เปนการสัง่ใหโปรแกรมทําการสั่ง Verify หรือ
ตรวจสอบความถูกตองของขอมูลดวยหลงัจากโปรแกรมเสร็จแลว 

 

 
 

  ทาํการสัง่กําหนดคาตวัเลือกพิเศษเพิ่มเตมิใหกับโปรแกรมอีก โดยใหทาํการคลิกเมาสที่
คําสั่ง “Options → More Options” แลวเลือกกาํหนดคาตางๆดังนี ้

 ใหคลิกเมาสหนาตัวเลือกของคําสั่ง “Verify Device Target ID” จนปรากฏ
เครื่องหมาย (√) หนาคําสั่ง เพื่อเปนการสัง่ใหโปรแกรมตรวจสอบความ
ถูกตองของเบอร MCU วาตรงตามทีเ่ลือกไวหรือไม 

 ใหเลือกการทาํงานของคาํสัง่ Program โดยใหเลือกกําหนดขัน้ตอนการ
ทํางานของคําสั่งดังนี ้ (Options → More Options → Program) 

• Code 
• Data 
• Configuration 
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 ใหเลือกการทาํงานของคาํสัง่ Verify โดยใหเลือกกําหนดขั้นตอนการทํางาน
ของคําสั่งดังนี ้(Options → More Options → Verify) 

• Code 
• Data 
• Configuration 
 

 ใหเลือกการทาํงานของคาํสัง่ Read โดยใหเลือกกําหนดขั้นตอนการทํางาน
ของคําสั่งดังนี ้(Options → More Options → Read) 

• Code 
• Calibration 
• Data 
• Used ID 
• Configuration 
• Device ID 
 

 ใหเลือกการทาํงานของคาํสัง่ Blank Check โดยใหเลอืกกําหนดขั้นตอนการ
ทํางานของคําสั่งดังนี ้(Options → More Options → Blank Check) 

• Code 
• Data 
• Configuration 
 

 ใหเลือกการทาํงานของคาํสัง่ Erase โดยใหเลือกกําหนดขั้นตอนการทํางาน
ของคําสั่งดังนี ้(Options → More Options → Erase) 

• Code 
• Data 
• Configuration / User ID 

 
ซึ่งหลงัจากกาํหนดคาตวัเลือกตางๆเหลานีเ้ปนทีเ่รียบรอยแลว คาทีก่ําหนดไวแลวนี้ จะคงอยู

ตลอดไปจนกวา จะมีการสัง่แกไขคาตัวเลือกเหลานี้ใหม ดังนั้นในครั้งตอๆไปก็สามารถเรียกใชงานโปรแกรม
ผานคําสัง่ตางๆที่ตองการไดทันที โดยไมจาํเปนตองมาทาํการกาํหนดคาเหลานี้อีกตอไป 
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9. ในการสัง่งานโปรแกรมนั้นสามารถทําได 3 แบบ คือการสั่งงานผานเมนูคําสัง่ หรือ การสัง่งานผาน 
Button ของคําสั่ง หรือการสัง่งานผานคียลัด (Hot Key) ของแตละคําสั่ง โดยไมวาจะเลือกใชวิธกีาร
ส่ังงานโปรแกรมดวยวิธกีารใดก็จะใหผลการทํางานที่เหมือนกนั โดยในการสัง่งานโปรแกรมมีดังนี ้

 ส่ังเปด Hex File ที่จะตองจะส่ังโปรแกรมไปยังหนวยความจาํของ MCU โดยใชเมนูคําสัง่ 
“File → Open…” หรือกดคีย “CTRL+O” หรือคลิกเมาสที่ Button คําสั่ง  แลวเลือก
กําหนดชื่อและที่อยูของ Hex File ตามตองการ 

 ส่ังตรวจสอบคา Configuration ของ MCU โดยใชคําสั่ง “View Configuration” หรือกดคีย 
“CTRL+F” หรือคลิกเมาสที ่ Button คําสั่ง  ซึ่งจะปรากฏหนาตางโปรแกรมสําหรบั
แสดงคา Configuration ของ MCU ที่ไดจาก Hex File ที่ส่ัง Open ไวแลวดังตัวอยาง 

 

 
 

รูปแสดงคา Configuration ของ dsPIC30F2010 ที่จะใชกับบอรด “ET-dsPIC30F2010” 
 

 ซึ่งตามปรกติแลวคาของ Configuration เหลานี้จะถกูกาํหนดไวในขั้นตอนของการพฒันาโปรแกรม
อยูแลว โดยผูใชตองรูและเขาใจเองวาโปรแกรมที่พฒันาขึ้นมามกีารทาํงานอยางไร จําเปนตองใชทรัพยากร
ใดบาง และการทํางานของโปรแกรมเกี่ยวของกับคาของ Configuration ใดๆบาง เพื่อจะไดกําหนดคาการ
ทํางานของ Configuration ใหกับโปรแกรมไดอยางถกูตองและสอดคลองกับโปรแกรม ซึ่งถาใชตัวแปลคําสั่ง
ของ Microchips นั้นคาของ Configuration จะถูกรวมไวใน Hex File ในขั้นตอนของการสัง่แปลโปรแกรม
ดวยอยูแลว โดยคาของ Configuration นี้จะเปลี่ยนแปลงไปตามขอมูลที่ไดจากการสั่ง Open Hex File 
ข้ึนมาในโปรแกรมโดยอัตโนมัติ แตอยางไรก็ตามถาหากวาในขัน้ตอนของการพัฒนาโปรแกรมนั้น ผูใชไมได
กําหนดคาของ Configuration ที่ถูกตองไวดวย ก็อาจสงผลทาํให MCU ไมสามารถทํางานไดอยางถกูตอง
ตามที่ตองการ โดยในกรณีของบอรด “ET-dsPIc30F2010” นั้นตองกาํหนดคาตัวเลอืกดังรูป 
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 ส่ังโปรแกรมขอมูลจาก Buffer (จาก Hex File) ใหกับหนวยความจําของ MCU โดยสั่งผาน
เมนูคําสัง่ “Program → Program” หรือกดคีย “CTRL+P” หรือคลิกเมาสที่คําสัง่  
โดยการทํางานของคําสัง่นี้จะเปนการสั่ง Download ขอมูลจาก Hex File ที่ส่ังเปดไวแลว
ไปยังหนวยความจําของ MCU ซึ่งหลงัจากเสร็จเรียบรอยแลวเมื่อเลือดสวิตชกําหนดโหมด
การทาํงานของบอรดกลับไปยังตําแหนง “RUN” จะเห็นวา MCU เร่ิมตนทํางานตามคําสั่ง
ในโปรแกรมทีส่ั่ง Download ใหในทนัที ่ โดยการทํางานของคําสัง่นี้จะมีลําดับข้ันตอนและ
กระบวนการทาํงานของคาํสัง่ตามที่กาํหนดไวแลวในขางตนอนัไดแก  

 Erase (Code ,Data ,Configuration/Used ID)  
 Program(Code, Data ,Configuration) 
 Verify(Code ,Data ,Configuration) 

 

 
↓ 

 

 
↓ 

 

 
 

รูปแสดง ลําดับขั้นการทาํงานของการสั่งงานดวยคําสั่ง “Program” 
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การตรวจสอบปญหา MCU ไมทํางานหลังการ Download แลว 
 ตามปรกติแลวหลงัจากทีท่ําการ Download Hex File ใหกับ MCU เปนที่เรียบรอยแลว หลังจากที่
เปลี่ยนโหมดการทํางานของบอรดจาก “PROG” มาเปน “RUN” เปนทีเ่รียบรอยแลว MCU จะเริ่มตนทาํงาน
ตามคําสั่งในโปรแกรมที่ทาํการ Download ใหทนัท ี ซึง่ถาเกิดปญหาหรือขอผิดพลาดขึ้นในระหวางขัน้ตอน
ของการ Download โปรแกรมนั้น โปรแกรมก็จะแจงขอผิดพลาดนัน้ๆใหทราบอยูแลว แตสําหรับในกรณีที่
ข้ันตอนของการ Download ไมเกิดอาการผิดพลาดใดๆเลย แต MCU ไมทํางานตามที่ตองการ หลังจากที่
การ Download เสร็จส้ินไปเรียบรอยแลว ปญหาที่มักพบอยูเสมอๆไดแก 

 การกําหนดคา Configuration ของ MCU กอนการสัง่ Download ไมถูกตองและสัมพันธ
กับฮารดแวรทีใ่ชงานอยู ซึง่ปญหานี้เปนปญหาที่พบบอยที่สุด ทั้งนี้ก็เนื่องมากจากวา การ
ทํางานของ MCU ตระกูล dsPIC นั้นจะใช Configuration เปนตัวกําหนดเงื่อนไขการ
ทํางานของวงจรภายในตางๆ ไมวาจะเปนการเลือกการทํางานของสญัญาณนาฬิกา การ
กําหนดการทาํงานของวงจร Watchdog และวงจร Brown-Out Detect ตางๆ ซึ่ง
รายละเอียดของคา Configuration ตางๆโดยละเอียดนัน้ ผูใชสามารถศึกษารายละเอียด
ไดจากหวัขอการกําหนดคา Configuration ของ dsPIC30F2010 แตในทีน่ี้จะขอกลาวถึง
เฉพาะในสวนที่ตองกาํหนดใหสอดคลองกับระบบฮารดแวรของ “ET-dsPIC30F2010” 
เทานั้น ซึง่ไดแก 

 สัญญาณนาฬกิาของบอรด “ET-dsPIC30F2010” จะใชวงจรกําเนดิความถี่
แบบ XTAL คา 7.3728 MHz โดยตอกับขาสัญญาณ OSC1 และ OSC2 โดย
ที่ MCU เบอร dsPIC30F2010 สามารถรับความถี่จากตัวกําเนิดความถี่แบบ 
XTAL ไดสูงสุด 10MHz และทํางานไดทีความถี่สูงสุด 120 MHz ดังนัน้เพื่อให
สามารถใชงาน MCU ไดอยางเตม็ประสทิธิภาพ จําเปนตองกาํหนดใหวงจร
คูณความถี่ (PLL) ทํางานดวย โดยคาอตัราการคูณความถี่ ทีเ่หมาะสมกับ
บอรด “ET-dsPIC30F2010” มากที่สุดคือ 16 เทา ซึ่งจะทําให MCU ทาํงานที่
ความถี ่117.9648 MHz โดยโปรแกรมตัวอยางตางๆทีจ่ดัทําขึ้นโดย อีทีที นัน้
จะอางองิคาความถี่ของสัญญาณนาฬิกาคา 117.9648 MHz เปนหลักดวย
เชนเดียวกนั โดยผูใชตองกาํหนดคา Configuration สําหรับเลือกสญัญาณ
นาฬิกาใหกับ MCU ดวยคาตัวเลือกดังนี ้

• กําหนด Oscillator Source เปน Primary Oscillator 
• กําหนด Primary Oscillator Mode เปน “XT w/PLL1 6X” 

ซึ่งถาผูใชเลือกกําหนดคา Configuration เปนอยางอืน่ จะทําให MCU ไม
ทํางานหรือทํางานไดไมถูกตองตามที่กําหนดไว 
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 การทาํงานของ Watchdog ควรกําหนดเปน “Disable” ไวกอน เพื่อเปนการ
ส่ังปดการทํางานของ Watchdog ไมใหทาํงาน เนื่องจากถากําหนดใหวงจร 
Watchdog ทํางานอยูแตโปรแกรมที่ผูใชเขียนขึ้นไมรองรับการใชงานรวมกบั 
Watchdog ดวย อาจเกิดความผิดพลาดขึ้น โดย MCU จะถูก Watchdog ส่ัง 
Reset อยูเร่ือยๆทําใหการทาํงานของโปรแกรมไมตอเนือ่ง ซึ่งดูเหมือน MCU 
ทํางานผิดพลาด โดยโปรแกรมตัวอยางของทาง อีทีท ี ก็จะไมไดจัดการเรื่อง 
Watchdog ดวยเชนกนั ดังนั้นถาตองการใชงานตัวอยางโปรแกรมของ อีทีท ี
ดวยจะตองสัง่ปดการทาํงานของ Watchdog ดวยเสมอ 

 
แตอยางไรก็ตาม ตัวอยางโปรแกรมทั้งหมดที่เขียนขึ้นโดย อีทที ี นัน้ไดทําการกาํหนดคาการ

ทํางานของ Configuration ตางๆที่เหมาะสมไวใน Source Code ของโปรแกรมดวยอยูแลว ผูใช
สามารถสัง่ Download Hex File ของตัวอยางโปรแกรมจาก อีทที ีตามคา Configuration ที่ไดจาก 
Hex File ไดทันทีโดยไมตองดัดแปลงหรือแกไขคา Configuration ใดๆใหเสียเวลาอีก 

 
 สวิตชเลือกโหมดถูกเลื่อนกลับมายงัตําแหนง “RUN” ไมหมดทําใหขาสัญญาณ MCLR ไม
เชื่อมตอกับวงจร RESET อยางถูกตองจงึทําให MCU ไมทํางาน 

 โปรแกรมที่ผูใชเขียนขึ้นนัน้ไมสามารถทาํงานไดอยางถกูตองเองอยูแลว ซึ่งปญหานี้อาจ
ทดสอบได โดยการทดลองสัง่ Download โปรแกรมตัวอยางที่ส่ังแปลเปน Hex File ไว
เรียบรอยแลว ซึ่งโปรแกรม ตัวอยาง ตางๆเหลานี้ ไดรับการทดสอบ แลววามีความถูกตอง
และทํางานไดจริงตามเงื่อนไขที่ทาง อีททีี กําหนดไว 

 ในกรณีที่การสั่ง Run โปรแกรม “melabs Programmer” แลวเกดิการผิดพลาดเรื่องการ 
โหลด Driver แสดงวาในขั้นตอนของการตดิตั้งโปรแกรมนั้นผูใชยังไมไดส่ังติดตั้ง Driver ไว
ดวย ใหทําการสั่งติดตั้ง Driver ใหเรียบรอยโดยสั่งงานผานเมนูคําสัง่ของ Windows โดยใช 
“Start → Program melabs → Programmer Beta → NT,2000,XP Driver Installer” 
จากนั้นก็จะสามารถเรยีกใชงานโปรแกรม “melabs Programmer” ไดตามปรกต ิ
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การกําหนดคา Configuration ใหกับ dsPIC30F2010 
 
 สําหรับ dsPIC30F2010 นั้นจะมีรีจิสเตอรพิเศษจํานวน 4 ชุด ซึ่งเรียกวา Configuration  Register 
สําหรับใชกาํหนดคุณสมบัติและควบคุมการทํางานของวงจรตางๆใน MCU ซึ่งการกาํหนดคาใหกบั
รีจิสเตอรพิเศษทั้ง 4 ชุดนี ้จะตองกระทําในข้ันตอนของการโปรแกรมดวยวิธกีารแบบ ICSP หรือจากเครื่อง
โปรแกรมภายนอกเทานั้น 
 โดยสําหรับบอรด Et-dsPIC30F2010 START KIT V1 / EXP นั้น ในกรณีที่ใชการพัฒนาโปรแกรม 
รวมกับชุดพฒันา “ET-CAP10 V2.0” รวมกับโปรแกรม “WinPic800” หรือ “melabs Programmer” นั้น จะ
สามารถกําหนดคาตัวเลือกตางๆใหกับ Configuration Register ผานทางหนาจอของโปรแกรมโดยตรง หรือ
กําหนดคาจากคา Configuration ที่ไดจาก HEX File ของ MPLAB C30 ก็ได ดังตัวอยาง 
 
/* Setup Configuration For ET-dsPIC30F2010 */ 
_FOSC(CSW_FSCM_ON &   // Enable Clock Switching 
      XT_PLL16);    // Enable Fail-Safe Clock 
                                                               //  Clock Source = Primary XT  
       // Enable Phase Lock Loop x 16 
_FWDT(WDT_OFF);   // Disable Watchdog  
_FBORPOR(PBOR_ON &    // Enable Brown-Out 
   BORV_45 &    // Brown-Out = 4.5 Volt 
   PWRT_64 &    // Power ON = 64 mS 
   MCLR_EN);   // Enable MCLR 
_FGS(CODE_PROT_OFF);  // Code Protect OFF 
/* End   Configuration For ET-dsPIC30F2010 */ 

 
 โดยรายรายละเอียดและ Keyword ของ Macro ทั้งหมดที่ใชในการกาํหนดคา Configuration ของ 
dsPIC30F2010 นั้น ผูใชสามารถดูไดจาก “..\pic30_tools\support\h\p30f2010a2.h” 
 
 ***หมายเหต*ุ** สําหรับบอรด ET-dsPIC30F2010 Training Kit V1.0 / EXP ของ อีททีี นัน้ ถา
ตองการใชงานกับโปรแกรมตัวอยางตางๆที่ทางอทีีท ี จดัทําขึ้นโดยไมเกิดปญหา จะตองเลือก Oscillator 
เปนแบบ “Primary” โดยใช “XT w/PLL 16X-XT crystal oscillator mode with 16X PLL” พรอมกับ
ยกเลิกบิต “FWDTEN” เพื่อปดการทํางานของ Watchdog ดวยเสมอ สวนตวัเลือกอื่นๆสามารถเลือก
กําหนดไดตามตองการ 
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FOSC (Oscillator Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F80000H 

ทําหนาที่สําหรับใชเลือกกําหนดคุณสมบติัและแหลงกาํเนิดของสัญญาณนาฬิกาทีจ่ะปอนใหกับ MCU ของ 
MCU เพื่อใชเปนสัญญาณนาฬิกาของระบบ ซึ่งตามปรกติแลวระบบสัญญาณนาฬกิาของ dsPIC30F2010 
จะสามารถเลอืกกําหนดไดหลายแหลงขึน้อยูกับการออกแบบวงจรใชงาน แตในกรณีทีใ่ชกับบอรด ET-
dsPIC30F2010 นั้น ระบบสัญญาณนาฬิกาจะไดรับการออกแบบใหใชงานกับตัวกําเนิดความถี่
แบบ XTAL คา 7.3728MHz และเพื่อใหสามารถใชงาน MCU ไดอยางเต็มประสิทธภิาพและ
สามารถใชงานกับตัวอยางโปรแกรมตางๆ ที่ทาง อีทีที จัดทาํขึน้ ไดโดยไมเกิดปญหาจะตองเลือก
กําหนดแหลงกําเนิดของสัญญาณนาฬิกาเปนแบบ “Primary Oscillator” รวมกับ “XT w/PLL 16x”  
เทานั้น ซึง่การเลือกคาดังกลาวเปนการเลือกกําหนดให MCU ใชสัญญาณนาฬิกาจากวงจรกาํเนิดความถี่
แบบ XTAL ซึ่ง ตอเขากับขา OSC1 และ OSC2 พรอมทั้งเปดการทาํงานของวงจรคูณความถี ่Phase-Lock-
Loop ดวยอัตราการคูณ 16 เทา ดวย ซึ่งจะสงผลใหคาความถีข่องสัญญาณนาฬิกาของบอรด ET-
dsPIC30F2010 มีคา 117.9648 MHz ซึ่งความถี่ของสญัญาณนาฬิกาดังกลาวจะถกูนําไปหารใหเหลือ ¼ 
กอนทีจ่ะปอนใหกับระบบของ MCU ดังนัน้คาความถี่ของสัญญาณนาฬกิาของระบบ ที่ใชในบอรด ET-
dsPIC30F2010 จะมีคาเทากับ 29.4912 MHz สําหรับรายละเอยีดการเลือกกาํหนดคาของบิตตางๆใน 
PSOC Configurations Register จะมีดังตอไปนี้ 
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต FCKSM[1:0] - - - - FOS[1:0] 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต - - - - FPR[3..0] 

  

ตาราง แสดงคาบิตตางๆของ FOSC Configurations Register 
 

- FCKSM[1:0] ใชสําหรับกาํหนดการทํางานของวงจรสลับสัญญาณนาฬิกาและตรวจสอบการ
ทํางานของสญัญาณนาฬิกา   

 0:0 = เปนการเลือกเปดการทํางาน (Enable) ทั้งสวนของวงจรสลับสัญญาณนาฬิกา 
และ วงจรตรวจสอบความผดิพลาดของสญัญาณนาฬิกา(Fail-Safe Clock Monitor) 

 0:1 = เปนการเลือกเปด (Enable) การทาํงานของวงจรสลับสัญญาณนาฬกิา แตใน
สวนของวงจรตรวจสอบความผิดพลาดของสัญญาณนาฬิกาจะถูกปด (Disable) ไว 
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 1:X = เปนการเลือกปด (Disable)ทั้งสวนของวงจรสลับสัญญาณนาฬิกา และ วงจร
ตรวจสอบความผิดพลาดของสัญญาณนาฬิกา (Fail-Safe Clock Monitor) 

 
- FOS[1:0] ใชสําหรับเลือกแหลงกาํเนิดสญัญาณนาฬิกาของ MCU ซึ่งสามารถเลือกได 4 แบบ 

แตสําหรับในกรณีของบอรด ET-dsPIC30F2010 ควรเลอืกเปน “1:1” เทานั้น 
 0:0 = เลือกใชสัญญาณนาฬกิาจาก XTAL 32KHz ภายใน MCU 
 0:1 = เลือกใชสัญญาณนาฬกิาจาก RC ภายในแบบยานความถี่สูง 
 1:0 = เลือกใชสัญญาณนาฬกิาจาก RC ภายในแบบยานความถี่ตํ่าและใชพลังงานต่ํา 
 1:1 = เลือกใชสัญญาณนาฬิกาจาก Primary Oscillator โดยกําหนดคุณสมบัติการ
ทํางานของวงจรรวมกับบิต FPR[3:0] อีกตอหนึง่ 

 
- FPR[3:0] ใชสําหรับเลือกการทํางานของสัญญาณนาฬกิาของ Primary Oscillator ซึ่งคาของ

ตัวเลือกในสวนนี้จะมีผลตอการทาํงานของ MCU ก็ตอเมื่อเลือกกาํหนดแหลงของสัญญาณ
นาฬิกาเปน Primary Oscillator แลว โดยคุณสมบัติการทํางานของ FPR{3:0] มีดังนี ้

 000x = “XLT” เปนการเลือกใช XTAL คา 200KHz-4MHz ตอกับขา OSC1,OSC2 
 001x = “HS” เปนการเลือกใช XTAL คา 10MHz-25MHz ตอกับขา OSC1,OSC2 
 0100 = “XT” เปนการเลือกใช XTAL คา 4MHz-10MHz ตอกับขา OSC1,OSC2 
 0101 = “XT PLL 4x” เปนการเลือกใช XTAL คาระหวาง 4MHz - 10MHz ตอเขากับ 

OSC1 และ OSC2 โดยเปดการทาํงานของวงจรคณูความถี่ (Phase-Lock-Loop) 
ดวยคาอัตราการคูณเปน 4 เทาของความถี ่XTAL ดวย 

 0110 = “XT PLL 8x” เปนการเลือกใช XTAL คาระหวาง 4MHz - 10MHz ตอเขากับ 
OSC1 และ OSC2 โดยเปดการทาํงานของวงจรคณูความถี่ (Phase-Lock-Loop) 
ดวยคาอัตราการคูณเปน 8 เทาของความถี ่XTAL ดวย 

 0111 = “XT PLL 16x” เปนการเลือกใช XTAL คาระหวาง 4MHz - 10MHz ตอเขา
กับ OSC1 และ OSC2 โดยเปดการทํางานของวงจรคณูความถี ่ (Phase-Lock-Loop) 
ดวยคาอัตราการคูณเปน 16 เทาของความถี่ XTAL ดวย 

 1000 = “ERCIO” เปนการเลือกใชสัญญาณนาฬิกาจากวงจร RC ภายนอก โดยตอ
เขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกต ิ

 1001 = “ERC” เปนการเลือกใชสัญญาณนาฬิกาจากวงจร RC ภายนอก โดยตอ
สัญญาณนาฬกิาเขากับขา OSC1 สวน OSC2 จะใชเปน Output ของสัญญาณ
นาฬิกาที่ได โดยมีคาความถี่เปน ¼ หรือ Fosc/4 
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 1011 = “EC” เปนการเลือกใชสัญญาณนาฬกิาคา 0-40MHz จากแหลงกาํเนิด
ภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน Output ของสัญญาณ
นาฬิกาที่รับจาก OSC1 โดยมีคาความถี่เปน ¼ หรือ Fosc/4 

 1100 = “ECIO” เปนการเลือกใชสัญญาณนาฬิกาคา 0-40MHz จากแหลงกาํเนิด
ภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 

 1101 = “EC PLL 4x” เปนการเลือกใชสัญญาณนาฬิกาคา 0-40MHz จาก
แหลงกาํเนิดภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 
โดยเปดการทาํงานของวงจรคูณความถี ่ (Phase-Lock-Loop) ดวยคาอัตราการคูณ
เปน 4 เทาของความถีท่ี่ปอนใหกับขา OSC1 ดวย 

 1110 = “EC PLL 8x” เปนการเลอืกใชสัญญาณนาฬกิาคา 0-40MHz จาก
แหลงกาํเนิดภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 
โดยเปดการทาํงานของวงจรคูณความถี ่ (Phase-Lock-Loop) ดวยคาอัตราการคูณ
เปน 8 เทาของความถีท่ี่ปอนใหกับขา OSC1 ดวย 

 1111 = “EC PLL 16x” เปนการเลอืกใชสัญญาณนาฬกิาคา 0-40MHz จาก
แหลงกาํเนิดภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 
โดยเปดการทาํงานของวงจรคูณความถี ่ (Phase-Lock-Loop) ดวยคาอัตราการคูณ
เปน 16 เทาของความถี่ทีป่อนใหกับขา OSC1 ดวย 

 
หมายเหต ุ การกําหนดคา Configuration ของ FOSC นั้น จะมีผลตอการทาํงานของ MCU 

โดยตรง ซึ่งถากําหนดไมถูกตองจะทาํให MCU ไมสามารถทาํงานได หรือทาํงานไดไมถูกตอง ถงึแมวาผูใช
จะเขียนโปรแกรมไดอยางถกูตองทกุประการก็ตามท ี โดยในกรณีของการใชงานบอรด “ET-
dsPIC30F2010” นัน้ จะเห็นไดวาวงจรกําเนิดความถีจ่ะถูกออกแบบใหใชตัวกาํเนิด XTAL คา 7.3728 
MHz ตอกับขา OSC1 และ OSC2 ของ MCU โดยตรง ซึง่นัน่กห็มายความวาการกาํหนดคา Configuration 
ของ FOSC ทีจ่ะใชงานกับบอรด “ET-dsPUIC30F2010” นั้นจะตองกาํหนดเปน Primary แบบ XT เทานั้น 
ซึ่งถาเลือกเปนอยางอื่นจะทําให MCU ไมสามารถทาํงานได แตในกรณีที่ตองการใชงานตัวอยางโปรแกรมที่
สรางโดย อีททีี จะตองกําหนดการทํางานของ FOSC ใหเปดการทํางานของวงจรคณูความถี่จากตัวกําเนิด
ความถี่คา 7.3728MHz ดวยอัตรา 16 เทาดวย (XT PLL16X) ถาเลือกเปน XT หรือ XT PLL 4 หรือ XT PLL 
8 ถึงแมวา MCU จะสามารถทํางานได แตก็จะสงผลทาํใหไดคาความถี่ ไมตรงกับที่คํานวณไวในโปรแกรม
จะทําใหการทาํงานของโปรแกรมไมถูกตอง เชน ความเร็วของการทํางานชาลง คาอัตรา Baud rate ของ
พอรตสื่อสารอนุกรมผิดเพีย้นไปเปนตน ดังนัน้ตองกาํหนดคา Configuration ของ FOSC เปนแบบ “XT 
PLL16” เสมอ MCU จึงจะทาํงานไดอยางถูกตอง 
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FWDT (Watchdog Timer Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F80002H 

ใชสําหรับกาํหนดการทํางานของ Watchdog ซึ่งในกรณทีี่ใชกับบอรด ET-dsPIC30F2010 และตองการใช
งานรวมกบัโปรแกรมตัวอยางตางๆที่ทางอทีีทีจัดทําขึน้ ควรกําหนดคาของบิต “PWTEN” ใหเปน “0” เพื่อ
ปดการทาํงานของ Watchdog ไวกอน ซึง่ถาตองการใชงาน Watchdog ผูใชอาจทาํการปรับปรุงการทาํงาน
ของโปรแกรมที่เขียนขึน้ โดยเพิ่มคําสั่งสาํหรับรีเซ็ตคาการนับของ Watchdog ในสวนตางๆของโปรแกรม
ตามความเหมาะสมแลวจงึสัง่เปดการทํางานของ Watchdog ในภายหลัง โดยคาตวัเลือกตางๆของ FWDT 
มีดังนี ้
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต - - FWPSA[1:0] FWPSB[3:0] 

 
 

ตาราง แสดงคาบิตตางๆของ FWDT Configurations Register 
 

- FWTEN ใชสําหรับกาํหนดการทาํงานของ Watchdog โดยถากําหนดใหบิตนี้เปน “1” จะเปน
การสั่งเปดการทํางานของ Watchdog ซึ่งในกรณนีี้ผูใชตองเขียนคาํสั่งเพื่อส่ังรีเซ็ตคาการนับ
ของ Watchdog กอนเกิดการ Overflow ในสวนตางๆของโปรแกรมเองดวย ไมเชนนั้นแลวเมื่อ
การนับของ Watchdog เกิดการ Overflow ข้ึน วงจร Watchdog จะสั่งรีการทํางานของ MCU 
ใหเร่ิมตนใหมทันที แตถากําหนดคาของบิตนี้ใหเปน “0” จะเปนการปดการทํางานของ 
Watchdog ซึ่งขอแนะนําใหส่ังปดการทาํงานของ Watchdog ไปกอน จนผูใชสามารถเขยีน
โปรแกรมไดอยางชาํนาญแลว ถาตองการใชงานวงจร Watchdog จึงคอยสั่งเปดการทํางาน
ของ Watchdog ตามตองการในภายหลัง 

- FWPSA[1:0] ใชสําหรับกําหนดคา Prescaler ของวงจร Prescale ชุด A เพื่อกาํหนดคาการ
ลดทอนความถี่สัญญาณนาฬิกาที่จะปอนใหกับวงจร Prescale ชุด B เพื่อใชเปนคาการนับ
ของ Watchdog 

 0:0 = กําหนดการ Prescale เปน 1:1 
 0:1 = กําหนดการ Prescale เปน 1:8 
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 1:0 = กําหนดการ Prescale เปน 1:64 
 1:1 = กําหนดการ Prescale เปน 1:512 

- FWPSB[3:0] ใชสําหรับกาํหนดคา Prescale ของวงจร Prescale ชุด B เพื่อกําหนดคาการนบั
ของ Watchdog โดยสามารถกําหนดได 16 ระดับคือ 

 0000 = กําหนดการ Prescale เปน 1:1 
. 
. 

 1110 = กําหนดการ Prescale เปน 1:15 
 1111 = กําหนดการ Prescale เปน 1:16 

 
หมายเหต ุการทํางานของวงจร Watchdog นัน้จะชวยเพิ่มประสทิธภิาพการทํางานของ MCU ใน

การใชงานใหเกิดประสิทธิภาพสงูสุด โดยในระบบไมโครคอนโทรเลอรนั้น จะอาศัย Watchdog ชวย
ตรวจสอบการทํางานของ MCU ไมใหหยุดทํางาน ซึง่เหมาะกับการใชงานวงจรทีต่องทําการอยางตอเนื่อง
ตลอดเวลาเปนเวลานานๆ ซึ่งหลกัการทํางานของวงจร Watchdog นั้นจะเปนวงจรนับอิสระวงจรหนึ่ง ซึง่
สามารถกําหนดคาการของจํานวนการนบัสูงสุด (Time-Out) ที่แนนอนใหกับวงจรได โดยเมือ่วงจรการนับ
ของ Watchdog นับไปจนถงึคาการนับสูงสุดแลวคาการนับจะกลบัมาเริ่มตนใหม ซึง่เรียกวาการ Overflow 
โดยในชวงนี้จะทําใหวงจร Watchdog สงสัญญาณไปรีเซ็ตการทํางานของ MCU ใหเร่ิมตนทํางานใหม 

ซึ่งเราจะใชประโยชนจากวงจร Watchdog ในการตรวจสอบการทาํงานของ MCU โดยการเขียน
คําสั่งสําหรับส่ังรีเซ็ตคาการนับของ Watchdog แทรกไวในสวนตางๆของโปรแกรม กอนที่คาการนับของ 
Watchdog จะเกิดการ Overflow ข้ึน แตถาหากวา MCU เกิดการหยุดการทํางานขึ้น ไมวาจะเกิดจาก
สาเหตุใดก็ตาม MCU ก็จะไมสามารสงสญัญาณไปรีเซ็ตคาการนับของ Watchdog ไดดังนั้น MCU ก็จะถูก 
Watchdog รีเซ็ตใหกลับมาเริ่มตนทาํงานใหมไดอีก 

แตอยางไรก็ตามในการพฒันาโปรแกรมใชงานนัน้ ถาผูพัฒนาโปรแกรมยังไมมีความชํานาญในการ
เขียนโปรแกรมเพียงพอ โดยเฉพาะในระหวางที่เปนชวงเริ่มตนของการเรียนรูนัน้ ควรสั่งปดการทํางานของ 
Watchdog ไวกอน ไมเชนนั้นแลวจะเปนการเพิม่ความสับสนใหกับผูใชได เนื่องจากถามีการแทรกคําสั่ง
สําหรับรีเซ็ตคาการนับของ Watchdog ไมเหมาะสมก็อาจทาํให Watchdog ส่ังรีเซ็ตการทํางานของ MCU 
ในขณะที ่ MCU กําลงัทาํงานตามโปรแกรมปรกติอยูก็เปนได ดังนัน้ขอแนะนาํใหส่ังปดการทํางานของ 
Watchdog ไวกอน จนเมือ่สามารถพัฒนาโปรแกรมรวมกับวงจรสวนอื่นๆ จนโปรแกรมสามารถทํางานได
อยางถูกตองครบทั้งหมดแลว จึงคอยเปดการทาํงานและแทรกคําสัง่สาํหรับ รีเซ็ตคาการนับของ Watchdog 
ในภายหลัง ซึ่งตัวอยางโปรแกรมตางๆทีท่าง อีททีี จัดทําขึ้นนัน้กไ็มไดจัดการเรื่อง Watchdog ไวดวย
เชนเดียวกนั ดังนัน้ควรกาํหนดคา Configuration ของ FWDT ใหปดการทํางานของ Watchdog ไวดวย 
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FBORPOR (BOR and POR Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F80004H 

ใชสําหรับกาํหนดการทํางานของวงจร Power-ON Reset และ Brown-Out Reset 
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต MCLREN - - - - PWMPIN HPOL LPOL 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต BOREN - BORV[1:0] - - FPWRT[1:0] 

 
 

ตาราง แสดงคาบิตตางๆของ FBORPOR Configurations Register 
 

- MCLREN ใชสําหรับกาํหนดการทํางานของขาสัญญาณ MCLR โดยถากาํหนดใหบิตนี้มีคา
เปน “1” จะเปนการเปดการทํางาน (Enable) ของขาสัญญาณ MCLR เปน External Reset 
ตามปรกติ แตถากําหนดใหบิตนี้มีคาเปน “0” จะเปนการปดการทํางาน (Disable) ของ
ขาสัญญาณ MCLR 

- PWMPIN ใชสําหรับกาํหนดการทํางานของขาสัญญาณ PWM ในระหวางการรีเซ็ต ซึ่งใน 
dsPIC30F2010 จะมีอยู 3 ชุด โดยถากาํหนดใหบิตนีม้ีคาเปน “1” จะเปนการกาํหนดใหขา 
Output ของ PWM ถูกควบคุมโดยวงจร Input/Output และมีสถานะเปน Tri-State ในระหวาง
เกิดการรีเซ็ตอยู แตถากาํหนดใหบิตนี้มีคาเปน “0” จะเปนการกาํหนดใหขา Output ของ PWM 
ถูกควบคุมจากวงจร PWM โดยในขณะเกดิการรีเซ็ตอยูจะมีสถานะเปน Output  

- HPOL ใชสําหรับกําหนดลกัษณะการทํางานของขา PWMH เมื่อเกดิการทํางาน (Active) โดย
ถากาํหนดใหบิตนี้มีคาเปน “1” จะเปนการกําหนดใหขาสัญญาณ PWMH เปน High ในขณะ 
Active แตถากําหนดใหบิตนี้เปน “0” จะเปนการกําหนดให PWMH เปน Low ในขณะ Active 

- LPOL ใชสําหรับกําหนดลักษณะการทํางานของขา PWML เมื่อเกดิการทํางาน (Active) โดย
ถากาํหนดใหบิตนี้มีคาเปน “1”จะเปนการกําหนดใหขาสัญญาณ PWML เปน High ในขณะ 
Active แตถากําหนดใหบิตนี้เปน “0” จะเปนการกําหนดให PWML เปน Low ในขณะ Active 

- BOREN ใชสําหรับกาํหนดการทาํงานของวงจร Brown-Out Reset โดยถากาํหนดเปน “1” จะ
เปนการเปดการทํางานของ Brown-Out แตถากาํหนดเปน “0” จะเปนการปดการทํางานของ 
Brown-Out 
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- BORV[1:0] ใชสําหรับกาํหนดระดับคาของแรงดันที่จะใชเปนจุดอางอิงในการตรวจสอบความ
ผิดพลาดของระดับแหลงจายของวงจร Brown-Out Reset 

 0:0 = ใหวงจร Brown-Out ทํางานเมื่อแรงดันต่ํากวา 4.5V 
 0:1 = ใหวงจร Brown-Out ทํางานเมื่อแรงดันต่ํากวา 4.2V 
 1:0 = ใหวงจร Brown-Out ทํางานเมื่อแรงดันต่ํากวา 2.7V 
 1:1 = ใหวงจร Brown-Out ทํางานเมื่อแรงดันต่ํากวา 2.0V 

 
- FPWRT[1:0] ใชสําหรับกาํหนดคาเวลาการทํางานของวงจร Power-ON Reset 

 0:0 = เปนการปดการทาํงาน (Disable) ของวงจร Power-ON Reset 
 0:1 = เปนการเลือกเปดการทํางานของวงจร Power-ON Reset โดยมีคาเวลา 4mS 
 1:0 = เปนการเลือกเปดการทํางานของวงจร Power-ON Reset โดยมีคาเวลา 16mS 
 1:1 = เปนการเลือกเปดการทํางานของวงจร Power-ON Reset โดยมีคาเวลา 64mS 
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FGS (General Code Segment Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที ่F8000AH 

ใชสําหรับกาํหนดระบบการปองกันขอมูลของหนวยความจําใน MCU 
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต - - - - - - GCP GWRP 

 
 

ตาราง แสดงคาบิตตางๆของ FGS Configurations Register 
 
 

- GCP ใชสําหรับกําหนดการปองกนัการอานขอมูลของหนวยความจําโปรแกรม หรือ Flash 
Memory จากภายนอก โดยถากาํหนดใหบิตนี้เปน “1” จะเปนการปด (Disable) ระบบปองกนั
การอานขอมูลจากหนวยความจํา Flash แตถาเลือกกาํหนดใหบิตนีเ้ปน “0” จะเปนการเปด 
(Enable) ระบบปองกนัการอานขอมูลจากหนวยความจํา Flash ซึ่งจะทําใหไมสามารถสั่งอาน
ขอมูลจากหนวยความจํา Flash ใน MCU จากภายนอกได โดยถาเลือกกําหนดใหบิตนี้มีคา
เปน “0” แลวจะไมสามารถสั่งเปลี่ยนคาใหกลับมาเปน “1” ไดอีก นอกจากจะสั่งลบขอมูลออก
จากหนวยความจําทัง้หมดเสียกอน ซึ่งหลงัจากสั่งลบขอมูลในหนวยความจําโปรแกรมทั้ง
หมดแลวบิตนีจ้ะมีคาเปน “1” โดยอัตโนมัติ 

- GWRP ใชสําหรับกําหนดการปองกนัการเขียนขอมูลของหนวยความจําโปรแกรม หรือ Flash 
Memory โดยถากาํหนดใหบิตนี้เปน “1” จะเปนการปด (Disable) ระบบปองกันการเขียน
ขอมูลใหมใหกับหนวยความจํา Flash แตถาเลือกกําหนดใหบิตนี้เปน “0” จะเปนการเปด 
(Enable) ระบบปองกนัการเขียนขอมูลใหกับหนวยความจํา Flash ซึ่งจะทาํใหไมสามารถสั่ง
เขียนขอมูลใหกับหนวยความจํา Flash ใน MCU เพิ่มเติมไดอีกจนกวาจะสั่งลบขอมูลเดิม
ทั้งหมดออกเสยีกอน โดยถาเลือกกําหนดใหบิตนี้มีคาเปน “0” แลวจะไมสามารถสัง่เปลี่ยนคา
ใหกลับมาเปน “1” ไดอีก นอกจากจะสั่งลบขอมูลออกจากหนวยความจําทัง้หมดเสยีกอน ซึง่
หลังจากสัง่ลบขอมูลในหนวยความจําโปรแกรมทั้งหมดแลวบิตนี้จะมคีาเปน “1” โดยอัตโนมัติ 

 



คูมือการใชงานบอรด ET-dsPIC30F2010 TRAINING KIT V1.0 / EXP 

ETT CO.,LTD -49- WWW.ETT.CO.TH 
 

 
 

รูปแสดง คา Configuration ที่เหมาะสมของ ET-dsPIC30F2010 โดยใช “WinPic800” 
 
 

 
 

รูปแสดง คา Configuration ที่เหมาะสมของ ET-dsPIC30F2010 โดยใช “melabs Programmer” 
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